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1. INTRODUCTION

The RCM3000 RabbitCore module is designed to be the heart of
embedded control systems. The RCM3000 features an inte-
grated Ethernet port and provides for LAN and Internet-enabled
systems to be built as easily as serial-communication systems.

Throughout this manual, the term RCM3000 refers to the complete series of RCM3000
RabbitCore modules unless other production models are referred to specifically.

The RCM3000 has a Rabbit 3000 microprocessor operating at 29.4 MHz, static RAM,
flash memory, two clocks (main oscillator and timekeeping), and the circuitry necessary
for reset and management of battery backup of the Rabbit 3000’s internal real-time clock
and the static RAM. Two 34-pin headers bring out the Rabbit 3000 1/O bus lines, parallel
ports, and serial ports.

The RCM3000 receives its +3.3 V power from the customer-supplied motherboard on
which it is mounted. The RabbitCore RCM3000 can interface with all kinds of CMOS-
compatible digital devices through the motherboard.

1.1 RCM3000 Features

e Small size: 1.85" x 2.65"” x 0.86"
(47 mm x 67 mm x 22 mm)

e Microprocessor: Rabbit 3000 running at 29.4 MHz

e 52 parallel 5V tolerant I/O lines: 44 configurable for 1/0, 4 fixed inputs, 4 fixed outputs
e Two additional digital inputs, two additional digital outputs

e External reset input

o Alternate 1/0O bus can be configured for 8 data lines and 6 address lines (shared with
parallel 1/0 lines), I/O read/write

e Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers
e 256K-512K flash memory, 128K-512K SRAM
¢ Real-time clock

e Watchdog supervisor
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e Provision for customer-supplied backup battery via connections on header J2

e 10/100-compatible RJ-45 Ethernet port with 10Base-T interface

e 10-bit free-running PWM counter and four width registers

e Two-channel Input Capture can be used to time input signals from various port pins

e Two-channel Quadrature Decoder accepts inputs from external incremental encoder

modules

e Six CMOS-compatible serial ports: maximum asynchronous baud rate of 1.84 Mbps,
maximum synchronous baud rate of 7.35 Mbps. Four ports are configurable as a
clocked serial port (SPI), and two ports are configurable as SDLC/HDLC serial ports.

e Supports 1.15 Mbps IRDA transceiver

There are two production models in the RCM3000 series. If the standard models do not
serve your needs, other variations can be specified and ordered in production quantities.
Contact your Rabbit Semiconductor sales representative for details.

Table 1 below highlights the differences between the two models in the RCM3000 family.

Table 1. RCM3000 Versions

Feature

RCM3000 RCM3010

Microprocessor

Rabbit 3000 running at 29.4 MHz

Flash Memory 512K 256K
Static RAM 512K 128K
6 shared high-speed, CMOS-compatible ports:
6 are configurable as asynchronous serial ports;
. 4 are configurable as clocked serial ports (SPI);
Serial Ports

2 are configurable as SDLC/HDLC serial ports;
1 asynchronous clocked serial port is dedicated
for programming

NOTE: The RCM3010 is the RabbitCore module supplied with the Development Kit.

In addition, there is an RCM3100 series of RabbitCore modules that omits the RCM3000
series’ Ethernet connectivity, but offer a much smaller footprint, which is about one-half

that of the RCM3000 series.

The RabbitCore modules can be programed locally, remotely, or via a network using
appropriate interface hardware.

Appendix A, “RCM3000 Specifications,” provides detailed specifications for the

RCM3000.

RabbitCore RCM3000



1.2 Advantages of the RCM3000
o Fast time to market using a fully engineered, “ready to run” microprocessor core.

e Competitive pricing when compared with the alternative of purchasing and assembling
individual components.

e Easy C-language program development and debugging
o Ultility programs for rapid production loading of programs.

e Generous memory size allows large programs with tens of thousands of lines of code,
and substantial data storage.

¢ Integrated Ethernet port for network connectivity, royalty-free TCP/IP software.
1.3 Development and Evaluation Tools

A complete Development Kit, including a Prototyping Board and Dynamic C develop-
ment software, is available for the RCM3000. The Development Kit puts together the
essentials you need to design an embedded microprocessor-based system rapidly and effi-
ciently.

1.4 How to Use This Manual

This user’s manual is intended to give users detailed information on the RCM3000 mod-
ule. 1t does not contain detailed information on the Dynamic C development environment
or the TCP/IP software support for the integrated Ethernet port. Most users will want more
detailed information on some or all of these topics in order to put the RCM3000 module to
effective use.

1.4.1 Additional Product Information

Information about the RCM3000 and its associated Development Kit and Prototyping
Board can be found in this RabbitCore RCM3000 User’s Manual, which is provided on
the accompanying CD-ROM in both HTML and Adobe PDF format.

In addition to the product-specific information contained in the RabbitCore RCM3000
User’s Manual (this manual), several higher level reference manuals are provided in
HTML and PDF form on the accompanying CD-ROM. Advanced users will find these
references valuable in developing systems based on the RCM3000 modules:

e Dynamic C User’s Manual

e Dynamic C Function Reference Manual
¢ An Introduction to TCP/IP

e Dynamic C TCP/IP User’s Manual

¢ Rabbit 3000 Microprocessor User’s Manual
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1.4.2 Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, use your browser to find and load default.htm in the docs
folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.
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2. HARDWARE SETUP

This chapter describes the RCM3000 hardware in more detail, and
explains how to set up and use the accompanying Prototyping Board.

NOTE: This chapter (and this manual) assume that you have the RCM3000 Development
Kit. If you purchased an RCM3000 module by itself, you will have to adapt the infor-
mation in this chapter and elsewhere to your test and development setup.

2.1 Development Kit Contents

The RCM3000 Development Kit contains the following items:

e RCM3010 module with Ethernet port, 256K flash memory, and 128K SRAM.
e RCM30/31/32XX Prototyping Board.

e AC adapter, 12 V DC, 1 A. (Included only with Development Kits sold for the North
American market. A header plug leading to bare leads is provided to allow overseas
users to connect a power supply compatible with their local mains power.)

¢ 10-pin header to DB9 programming cable with integrated level-matching circuitry.
e Dynamic C CD-ROM, with complete product documentation on disk.

e (Getting Started instructions.

e A bag of accessory parts for use on the Prototyping Board.

e Rabbit 3000 Processor Easy Reference poster.

¢ Registration card.
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2.2 Hardware Connections
2.2.1 Attach Module to Prototyping Board

Turn the RCM3000 module so that the Ethernet connector end of the module extends off
the Prototyping Board, as shown in Figure 1 below. Align the pins from headers J1 and J2
on the bottom side of the module into header sockets RCM2JA and RCM2JB on the Proto-
typing Board (these sockets were labeled J12 and J13 on earlier versions of the Prototyping
Board).

= [e]e]e]e]e]e]e]e]elo]e]o]c]e]e]o]e]e]o]e]e]0]e]e]0]e]e;
000000000000 000O0000OOO000000O000OJ
¢ 000000000000 000O00O00OOO0000000O00OJ

000000000000 000O0000O0O0000000000OJ
Zg 0000000000000 00000O0O0OO0O0000O0000000
0000000000000 000000O00OO0O0000O000000
0000000000000 000000O00OOO0O000O0000000
0000000000000 000000O0OO0O0000O0000000
OOOOOOq

Do not press down
here.

o por

uuuuuuuuuu

Figure 1. Install the RCM3000 Module on the Prototyping Board

Although you can install a single module into either the MASTER or the SLAVE position
on the Prototyping Board, all the Prototyping Board features (switches, LEDs, serial port
drivers, etc.) are connected to the MASTER position — install a single module in the
MASTER position.

NOTE: Itisimportant that you line up the pins on headers J1 and J2 of the RCM3000
module exactly with the corresponding pins of sockets RCM2JA and RCM2JB on the
Prototyping Board. The header pins may become bent or damaged if the pin alignment
is offset, and the module will not work. Permanent electrical damage to the module may
also result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board header sockets—press down in
the area above the header pins using your thumbs or fingers over the connectors as shown
in Figure 1. Do not press down on the middle of the RCM3000 module to avoid flexing
the module, which could damage the module or the components on the module.

Should you need to remove the RCM3000 module, grasp it with your fingers along the sides
by the connectors and gently work the module up to pull the pins away from the sockets
where they are installed. Do not remove the module by grasping it at the top and bottom.
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2.2.2 Connect Programming Cable

The programming cable connects the RCM3000 module to the PC running Dynamic C to
download programs and to monitor the module for debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J3 on
the RCM3000 module as shown in Figure 2. Be sure to orient the marked (usually red)
edge of the cable towards pin 1 of the connector. (Do not use the DIAG connector, which is
used for a normal serial connection.)

NOTE: Be sure to use the programming cable (part number 101-0513) supplied with this
Development Kit—the programming cable has red shrink wrap around the RS-232 con-
verter section located in the middle of the cable. Programming cables with blue or clear
shrink wrap from other from other Rabbit Semiconductor Kits were not designed to work
with RCM3000 modules.

, [eTer01010]
0000000000000 QOOOOO
- 000000000000000000000000000)

000000000000000000000000000000000)

4 [0000000000000000000000000000000000)
000000000000000000000000000000000)
00000000000000000000000000000000000)
””””” E 00000000000000000000000000000000000)
E 00000000000000000000000000000000000)
00000000000000000000000000000000000)
@QQPoooooooPQQQ@QQQQQQQQQQQQQQQQQQ@ ’

29568955395503d

0[O O A Q0 QO0L
00 ]ngmmgg Te e fiiiii: w o
00l O . i MTYYYYYYYYYYw || I
O O Ol
0 O Olpe

93 3L

e ) To

ook ik = PC COM port

g i \

Qo s - Colored

= > Pl _m - [P shrink wrap

Colored edge

Programming Cable

Figure 2. Connect Programming Cable to RCM3000

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use
an RS-232/USB converter with the programming cable supplied with your RabbitCore
module. An RS-232/USB converter is available through the Web store. Note that not all
RS-232/USB converters work with Dynamic C.
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2.2.3 Connect Power

When all other connections have been made, you can connect power to the Prototyping
Board.

Connect the wall transformer to jack J11 on the Prototyping Board as shown in Figure 3
below.

3-pin
power connector

00000000000
0000000000000

= 000000000000000O00000000O000
00000000000000000000000000000000]
2 [pPOOOOOOOO0O0O000O000O000000O00O00O00000]

00000000000000000000000000000000]
0000000000000 0000000O0000000000000J
000000000000000000000000C0O000000000]
000000000000000000000000C0O000000000]
0000000000000000000000000000000000]
QOOOOOOOOOq

gl

RCM30/31/32XX SERIES
g PROTOTYPING BOARD

uuuuuuuuuuuu

Figure 3. Power Supply Connections

Plug in the wall transformer. The power LED on the Prototyping Board should light up.
The RCM3000 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow hardware reset
without disconnecting power.

To power down the Prototyping Board, unplug the power connector from J11. You should
disconnect power before making any circuit adjustments in the prototyping area, changing
any connections to the board, or removing the RCM3000 from the Prototyping Board.

2.2.3.1 Overseas Development Kits

Development kits sold outside North America include a header connector that may be
connected to 3-pin header J9 on the Prototyping Board. The connector may be attached
either way as long as it is not offset to one side. The red and black wires from the connec-
tor can then be connected to the positive and negative connections on your power supply.
The power supply should deliver 8 V-24 V DC at 8 W.
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2.3 Run a Sample Program

If you already have Dynamic C installed, you are now ready to test your programming
connections by running a sample program.

If you are using a USB port to connect your computer to the RCM3000 module, choose
Options > Project Options and select “Use USB to Serial Converter” under the
Communications tab.

Find the file PoNG. ¢, which is in the Dynamic C sampLES folder. To run the program,
open it with the File menu (if it is not still open), compile it using the Compile menu, and
then run it by selecting Run in the Run menu. The STDIO window will open and will dis-
play a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in
Section 6.10, “Run the PINGME.C Sample Program,” tests the TCP/IP portion of the board.

2.3.1 Troubleshooting

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load the sample program, it is possible that
your PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Choose a lower debug baud rate.

If there are any other problems:

e Check to make sure you are using the PROG connector, not the DIAG connector, on
the programming cable.

e Check both ends of the programming cable to ensure that they are firmly plugged into
the PC and the programming port on the RCM3000.

e Ensure that the RCM3000 module is firmly and correctly installed in its connectors on
the Prototyping Board.

o Select a different COM port within Dynamic C. From the Options menu, select
Project Options, then select Communications. Select another COM port from the
list, then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If
Dynamic C still reports it is unable to locate the target system, repeat the above steps until
you locate the active COM port.
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2.4 Where Do | Go From Here?

We recommend that you proceed to the next chapter and install Dynamic C (if you do not
already have it installed), then run the ponG. ¢ sample program to verify that the
RCM3000 module and the Prototyping Board are set up and functioning correctly.

If everything appears to be working, we recommend the following sequence of action:

1. Run all of the sample programs described in Chapter 3 to get a basic familiarity with
Dynamic C and the RCM3000 module’s capabilities.

2. For further development, refer to the RabbitCore RCM3000 User’s Manual for details
of the module’s hardware and software components.

3. For advanced development topics, refer to the Dynamic C User’s Manual and the
Dynamic C TCP/IP User’s Manual, also in the online documentation set.

2.4.1 Technical Support

NOTE: If you purchased your RCM3000 through a distributor or through a Rabbit Semi-
conductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:
e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Rabbit Semiconductor Technical Bulletin Board at
www.rabbit.com/support/bb/.

e Use the Technical Support e-mail form at www.rabbit.com/support/.
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3. RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM3000 (and for all
other Rabbit Semiconductor hardware), you must install and use
Dynamic C.

3.1 Introduction

To help familiarize you with the RCM3000 modules, Dynamic C includes several sample
programs. Loading, executing and studying these programs will give you a solid hands-on
overview of the RCM3000’s capabilities, as well as a quick start with Dynamic C as an
application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of the C
programming language. If you do not, see the introductory pages of the Dynamic C
User’s Manual for a suggested reading list.

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.
In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM3000 module must be plugged in to the Prototyping Board as described in
Chapter 2, “Hardware Setup.”

2. Dynamic C must be installed and running on your PC.

3. The RCM3000 module must be connected to your PC through the serial programming
cable.

4. Power must be applied to the RCM3000 through the Prototyping Board.
Refer to Chapter 2, “Hardware Setup,” if you need further information on these steps.

To run a sample program, open it with the File menu, then press function key F9 to com-
pile and run the program.
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3.2 Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the
RCM3000. Sample programs illustrating the general operation of the RCM3000, and
serial communication are provided in the saMmpLES\RCM3000 folder. Each sample pro-
gram has comments that describe the purpose and function of the program. Follow the
instructions at the beginning of the sample program.

CONTROLLED. C—Uses the STDIO window to demonstrate digital outputs by toggling
LEDs DS1 and DS2 on the Prototyping Board on and off.

Parallel Port G bit 6 = LED DS1
Parallel Port G bit 7 = LED DS2

Once you have compile this program and it is running, you will be prompted via the
Dynamic C STDIO window to select LED DS1 or DS2. Use your PC keyboard to make
your selection.

Once you have selected the LED, you will be prompted to select to turn the LED either
ON or OFF. A logic low will light up the LED you selected.

FLASHLED1.c—(demonstrates the use of costatements to flash LEDs DS1 and DS2 on
the Prototyping Board at different rates. Once you have compile this program and it is
running, LEDs DS1 and DS2 will flash on/off at different rates.

FLASHLED2 . c—demonstrates the use of cofunctions and costatements to flash LEDs
DS1 and DS2 on the Prototyping Board at different rates. Once you have compile this
program and it is running, LEDs DS1 and DS2 will flash on/off at different rates.

TOGGLESWITCH.c—demonstrates the use of costatements to detect switches using the
press-and-release method of debouncing. LEDs DS1 and DS2 on the Prototyping
Board are turned on and off when you press switches S2 and S3.

IR DEMO.c—Demonstrates sending Modbus ASCII packets between two Prototyping
Board assemblies via the IrDA transceivers with the IrDA transceivers facing each other.
Note that this sample program will only work with the RCM30/31/32XX Prototyping
Board.

First, compile and run this program on one Prototyping Board assembly, then remove
the programming cable and press the RESET button on the Prototyping Board so that
the first RabbitCore module is operating in the Run mode. Then connect the program-
ming cable to the second Prototyping Board assembly with the RCM3000 and compile
and run the same sample program. With the programming cable still connected to the
second Prototyping Board assembly, press switch S2 on the second Prototyping Board
to transmit a packet. Once the first Prototyping Board assembly receives a test packet, it
will send back a response packet that will be displayed in the Dynamic C STDIO win-
dow. The test packets and response packets have different codes.

Once you have loaded and executed these sample programs and have an understanding of
how Dynamic C and the RCM3000 modules interact, you can move on and try the other
sample programs, or begin building your own.
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3.2.1 Serial Communication
The following sample programs can be found in the sAMPLES\RCM3000\SERIAL folder.

e FLOWCONTROL.C—This program demonstrates hardware flow control by configuring
Serial Port C (PC3/PC2) for CTS/RTS with serial data coming from TxB at 115,200 bps.
One character at a time is received and is displayed in the STDIO window.

To set up the Prototyping Board, you will need to tie TxB and RxB
together on the RS-232 _header at Jb, a_nd you will also tie TxC a_nd Js
RxC together using the jumpers supplied in the Development Kit as =I=lo o
shown in the diagram.

A repeating triangular pattern should print out in the STDIO window.
The program will periodically switch flow control on or off to demonstrate the effect of
no flow control.

e PARITY.C—This program demonstrates the use of parity modes by
repeatedly sending byte values 0-127 from Serial Port B to Serial Port | 2che
C. The program will switch between generating parity or not on Serial -TX@B;; GONDJ5
Port B. Serial Port C will always be checking parity, so parity errors
should occur during every other sequence.

To set up the Prototyping Board, you will need to tie TxB and RxC together on the
RS-232 header at J5 using the jumpers supplied in the Development Kit as shown in the
diagram.

The Dynamic C STDIO window will display the error sequence.

e SIMPLE3WIRE.C—This program demonstrates basic RS-232 serial
communication. Lower case characters are sent by TxC, and are RiC TxC
received by RxB. The characters are converted to upper case and are D J5
sent out by TxB, are received by RxC, and are displayed in the
Dynamic C STDIO window.

To set up the Prototyping Board, you will need to tie TxB and RxC together on the
RS-232 header at J5, and you will also tie RxB and TxC together using the jumpers
supplied in the Development Kit as shown in the diagram.

e SIMPLESWIRE.C—This program demonstrates 5-wire RS-232 serial communication
with flow control on Serial Port C and data flow on Serial Port B.

To set up the Prototyping Board, you will need to tie TxB and RxB
together on the RS-232 _header at J5, a'nd you will also tie TxC qnd Js
RxC together using the jumpers supplied in the Development Kit as =B 0o
shown in the diagram.

Once you have compiled and run this program, you can test flow con-

trol by disconnecting TxC from RxC while the program is running. Characters will no
longer appear in the STDIO window, and will display again once TxC is connected
back to RxC.
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e SWITCHCHAR.C—This program demonstrates transmitting and then receiving an
ASCII string on Serial Ports B and C. It also displays the serial data received from both
ports in the STDIO window.

To set up the Prototyping Board, you will need to tie TxB and RxC
together on the RS-232 header at J5, and you will also tie RxB and e e
TxC together using the jJumpers supplied in the Development Kit as D J5
shown in the diagram.

Once you have compiled and run this program, press and release S2
and S3 on the Prototyping Board. The data sent between the serial ports will be dis-
played in the STDIO window.

Two sample programs,

ceiver such as the SP483E and bias +
resistors to the RCM30/31/32XX -
Prototyping Board.

SIMPLE485MASTER. C and Ve
SIMPLE485SLAVE.C, are available to Ve 485+

illustrate RS-485 master/slave com- T bia% 681 Q
munication. To run these sample pro- PCO DI A

grams, you will need a second Rabbit- PC1 RO Rs-485 termi-< 220 O
based system with RS-485, and you PD4 De| CHIP 1s reter

will also have to add an RS-485 trans- GND_/RLE_L bias < 681 Q

485—

The diagram shows the connections. You will have to connect PCO and PC1 (Serial Port D)
on the RCM30/31/32XX Prototyping Board to the RS-485 transceiver, and you will con-
nect PD4 to the RS-485 transceiver to enable or disable the RS-485 transmitter.

The RS-485 connections between the slave and master devices are as follows.

* RS485+ to RS485+
* RS485-to RS485-
* GNDto GND

e SIMPLE485MASTER.C—This program demonstrates a simple RS-485 transmission of
lower case letters to a slave RCM3000. The slave will send back converted upper case
letters back to the master RCM3000 and display them in the STDIO window. Use
SIMPLE485SLAVE. C to program the slave RCM3000.

e SIMPLE485SLAVE.C—This program demonstrates a simple RS-485 transmission of
lower case letters to a master RCM3000. The slave will send back converted upper case
letters back to the master RCM3000 and display them in the STDIO window. Use
SIMPLE485MASTER. C to program the master RCM3000.

3.2.2 Other Sample Programs

Section 6.11 describes the TCP/IP sample programs, and Appendix C.8 provides sample
programs for the optional LCD/keypad module that can be installed on the Prototyping
Board.
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4. HARDWARE REFERENCE

Chapter 3 describes the hardware components and principal hardware
subsystems of the RCM3000. Appendix A, “RCM3000 Specifica-
tions,” provides complete physical and electrical specifications.

Figure 4 shows these Rabbit-based subsystems designed into the RCM3000.

32 kHz || 14 MHz
oSsC oscC
SRAM RABBIT ® logic-level serial signal
3000
Flash
Level
converter
Ethernet
RS-232, RS-485, IRDA
serial communication
RabbitCore Module drivers on motherboard

Figure 4. RCM3000 Subsystems
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4.1 RCM3000 Digital Inputs and Outputs

The RCM3000 has 52 parallel 1/0 lines grouped in seven 8-bit ports available on headers
J1 and J2. The 44 bidirectional 1/O lines are located on pins PAO-PA7, PBO, PB2-PB7,

PD2-PD7, PEO-PE1, PE3-PE7, PFO-PF7, and PGO-PG7.
Figure 5 shows the RCM3000 pinouts for headers J1 and J2.

J1 J2
GND | m o[ ] STATUS /RES [|m o[ ]PBO
PA7[ o o[ 1 PA6 PB2 | o o[ 1PB3
PA5[|o o[ PA4 PB4 o o[ ]PB5
PASL |0 o[ JPA2 PB6 |oc o[ 1PB7
PA1[|o o[ 1PAO PF4 o o[ JPF5
PF3[|o o[ 1PF2 PF6 o o[ 1PF7
PF1[|o o[ ]PFO PE7[|o o[ PE6
PCO|o o[ ]PC1 PE5 o o[ PE4
PC2 o o|[1PC3 PE3 | o o[ JPE1
PC4[|o ol 1PC5 PEO o o[ PG7
PC6 o ol 1PC7 PG6 o o[PG5
PGO[ | o o| 1 PG1 PG4 L[] o o[ 1/IOWR
PG2[ |0 o|1PG3 /IORD [ o ©[—] SMODEO
PD4[_|o o[ 1PD5 SMODE1 | © o[ J/RESET_IN
PD2|o o[ 1PD3 VRAM | o 5[] VBAT EXT
PD6 o o[ JPD7 +33v ] o o[ JGND
nec.C|o o[ Jne. nc. L]0 o[ JGND

n.c. = not connected
Note: These pinouts are as seen on
the Bottom Side of the module.

Figure 5. RCM3000 Pinouts

Headers J1 and J2 are standard 2 x 34 headers with a nominal 2 mm pitch. An RJ-45 Ether-
net jack is also included with the RCM3000.

The signals labeled PD2, PD3, PD6, and PD7 on header J1 (pins 29-32) and the pins that
are not connected (pins 33-34 on header J1 and pin 33 on header J2) are reserved for
future use on other models in the RCM3000.
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Figure 6 shows the use of the Rabbit 3000 ports in the RCM3000 modules.

PCO, PC2, PC4 4
PC1, PC3, PC5 M)

PG2, PG6 {um
PG3, PG7 I

PC6
PB1, PC7, /IRES

4 Ethernet signaIsH

nitst

PBO,
PAO-PAT PB2-PB7 PD4-PD5
Port D
PortA Port B (+Ethernet Port)
Port C
(Serial Ports B.,C & D) | I =J¥-1-7} A& Port E
3000
Port G
(Serial Ports E & F) Port F
Programming Real-Time Clock Port G
(Serial Port A Watchdog (TR
11 Timers
Ethernet Slave Port Misc. 1/0
e Clock Doubler
RAM Backup Battery Flash

Support

EO-PEA1,

P
PE3-PE7

PFO-PF7

PG0-PG1,

PG4-PG5

/RES_IN
/IORD

/RESET,
/IOWR,
STATUS
SMODEO
SMODE1

Figure 6. Use of Rabbit 3000 Ports

The ports on the Rabbit 3000 microprocessor used in the RCM3000 are configurable, and
so the factory defaults can be reconfigured. Table 2 lists the Rabbit 3000 factory defaults
and the alternate configurations.
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Table 2. RCM3000 Pinout Configurations

Pin Pin Name Default Use Alternate Use RCM3000 Use
1 GND
2 STATUS Output (Status) Output
External data bus
3-10  |PA[7:0] Parallel 1/0 Slg\zogggz)ata bus External Data Bus
(SD0-SD7)
11 PF3 Input/Output QD2A
12 PF2 Input/Output QD2B
13 PF1 Input/Output g:jié
14 PFO Input/Output g:jii
15 PCO Output TXD
16 PC1 Input RXD
17 PC2 Output TXC
= |18 PC3 Input RXC
% 19 PC4 Output TXB
T 20 PC5 Input RXB
21 PC6 Output TXA Serial Port A
22 PC7 Input RXA (programming port)
23 PGO Input/Output TCLKF
24 PG1 Input/Output RCLKF
25 PG2 Input/Output TXF
26 PG3 Input/Output RXF
27 PD4 Input/Output ATXB
28 PD5 Input/Output ARXB
29 PD2 Input/Output TPOUT-*
Ethernet transmit port
30 PD3 Input/Output TPOUT+ *
31 PD6 Input/Output TPIN-~*
Ethernet receive port
32 PD7 Input/Output TPIN+ *
33-34*|n.c. Not connected
* Pins 29-34 are reserved for future RCM3000 RabbitCore modules.
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Table 2. RCM3000 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use RCM3000 Use
1 /IRES Reset output Reset input Reset output from Reset
Generator
2 PBO Input/Output CLKB
3 PB2 Input/Output IA0 External Address 0
pUERLD JSWR
4 PB3 Input/Output IAL External Address 1
pUERLD JSRD
5 PB4 Input/Output IA2 External Address 2
puEL SAO
1A3
6 PB5 Input/Output External Address 3
SAl
7 PB6 Input/Output 1A4 External Address 4
8 PB7 Input/Output IAS External Address 5
putidtp ISLAVEATTN
AQDI1B
9 PF4 Input/Output
npuvLtpu PWMO
N
o AQD1A
2 |10 PF5 Input/Output Q
S PWM1
T o0z
AQD2B
11 PF6 Input/Output PWM2
AQD2A
12 PF7 Input/Output PWMS3
13 PE7 Input/Output 7
pUERL /SCS
14 PE6 Input/Output 16
15
15 PE5 Input/Output
INT1B
16 PE4 Input/Output 14
putodtp INTOB
17 PE3 Input/Output 13
18 PE1 Input/Output 11
putiodtp INTIA
19 PEO Input/Output 10
pUERLD INTOA

User’s Manual
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Table 2. RCM3000 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use RCM3000 Use
20 PG7 Input/Output RXE
21 PG6 Input/Output TXE
22 PG5 Input/Output RCLKE
23 PG4 Input/Output TCLKE
24 /IOWR Output External write strobe
25 /IORD Input External read strobe
(0,0)—start executing at address zero
(0,1)—cold boot from slave port
SMODEO. (1,0)—cold boot from clocked Serial Port A Also connected to
26-27 .
~ SMODE1 programming cable
= SMODEO =1, SMODE1 =1
§ Cold boot from asynchronous Serial Port A at
£ 2400 bps (programming cable connected)
28 /RESET_IN | Input Input to Reset Generator
Maximum Current Draw
29 VRAM Output 15 uA
30 |VBAT EXT |3V battery Input Minimum battery
- yinp voltage 2.8 V
31 +3.3V Input 3.15-3.45V DC
32 GND
Future option for +5 V
3 n.c. input or +5 V output
34 GND

NOTE: Ports PD0 and PE2 are used for the Ethernet interface.

Locations R38-R43 allow the population of 0 Q resistors (jumpers) that will be used to
enable future options. These locations are currently unused.
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4.1.1 Memory I/O Interface

The Rabbit 3000 address lines (A0-A19) and all the data lines (D0-D7) are routed inter-
nally to the onboard flash memory and SRAM chips. 1/0 write (/IOWR) and 1/0 read
(/IORD) are available for interfacing to external devices.

Parallel Port A can also be used as an external I/0O data bus to isolate external 1/0 from the
main data bus. Parallel Port B pins PB2—PB7 can also be used as an external address bus.

When using the auxiliary 1/0 bus, you must add the following line at the beginning of
your program.

#define PORTA AUX IO // required to enable auxiliary I/O bus

The STATUS output has three different programmable functions:

5. It can be driven low on the first op code fetch cycle.

6. It can be driven low during an interrupt acknowledge cycle.
7. It can also serve as a general-purpose output.

4.1.2 Other Inputs and Outputs

Two status mode pins, SMODEO and SMODE1, are available as inputs. The logic state of
these two pins determines the startup procedure after a reset.

/RESET _IN is an external input used to reset the Rabbit 3000 microprocessor and the
RabbitCore RCM3000 memory. /RES is an output from the reset circuitry that can be used
to reset other peripheral devices.

4.1.3 5V Tolerant Inputs

The RCM3000 operates over a voltage from 3.15 V to 3.45 V, but most RCM3000 input
pins, except /RESET _IN, VRAM, VBAT_EXT, and the power-supply pins, are 5 V toler-
ant. When a 5 V signal is applied to 5 V tolerant pins, they present a high impedance even if
the Rabbit power is off. The 5 V tolerant feature allows 5 V devices that have a suitable
switching threshold to be connected directly to the RCM3000. This includes HCT family
parts operated at 5 V that have an input threshold between 0.8 and 2 V.

NOTE: CMOS devices operated at 5 V that have a threshold at 2.5 V are not suitable for
direct connection because the Rabbit 3000 outputs do not rise above VDD, and is often
specified as 3.3 V. Although a CMOS input with a 2.5 V threshold may switch at 3.3 V,
it will consume excessive current and switch slowly.

In order to translate between 5V and 3.3 V, HCT family parts powered from 5 V can be
used, and are often the best solution. There is also the “LVT” family of parts that operate
from 2.0 V to 3.3V, but that have 5 V tolerant inputs and are available from many suppli-
ers. True level-translating parts are available with separate 3.3 VV and 5 V supply pins, but
these parts are not usually needed, and have design traps involving power sequencing.
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4.2 Serial Communication

The RCM3000 board does not have an RS-232 or an RS-485 transceiver directly on the
board. However, an RS-232 or RS-485 interface may be incorporated on the board the
RCM3000 is mounted on. For example, the Prototyping Board has a standard RS-232
transceiver chip.

4.2.1 Serial Ports

There are six serial ports designated as Serial Ports A, B, C, D, E, and F. All six serial ports
can operate in an asynchronous mode up to the baud rate of the system clock divided by 16.
An asynchronous port can handle 7 or 8 data bits. A 9th bit address scheme, where an addi-
tional bit is sent to mark the first byte of a message, is also supported. Serial Ports A, B, C,
and D can also be operated in the clocked serial mode. In this mode, a clock line synchro-
nously clocks the data in or out. Either of the two communicating devices can supply the
clock. When the Rabbit 3000 provides the clock, the baud rate can be up to 80% of the sys-
tem clock frequency divided by 128, or 183,750 bps for a 29.4 MHz clock speed.

Serial Ports E and F can also be configured as SDLC/HDLC serial ports. The IRDA proto-
col is also supported in SDLC format by these two ports.

Serial Port A is available only on the programming port.
4.2.2 Ethernet Port

Figure 7 shows the pinout for the
RJ-45 Ethernet port (J4). Note that
some Ethernet connectors are num-
bered in reverse to the order used

here. ’ 1 ’
Two LEDs are placed next to the l@*

ETHERNET

RJ-45 Ethernet jack, one to indicate e

an Ethernet link (LNK) and one to gi E:EXXZ

indicate Ethernet activity (ACT). s R.;45_Jx_k
- ug - ac

The Ethernet signals are also avail-

able on header J1. Figure 7. RJ-45 Ethernet Port Pinout

The transformer/connector assembly ground is con-

nected to the RCM3000 printed circuit board digital
ground via a 0 Q resistor, R31, as shown in
Figure 8. RJ-45 Ethernet Jack
The RJ-45 connector is shielded to minimize EMI l l
effects to/from the Ethernet signals. R31
Board Chassis
Ground = = Ground

Figure 8. Isolation Resistor R31
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4.2.3 Serial Programming Port

The RCM3000 serial programming port is accessed using header J3 or over an Ethernet
connection via the RabbitLink EG2110. The programming port uses the Rabbit 3000’s
Serial Port A for communication. Dynamic C uses the programming port to download and
debug programs.

The programming port is also used for the following operations.
e Cold-boot the Rabbit 3000 on the RCM3000 after a reset.

e Remotely download and debug a program over an Ethernet connection using the
RabbitLink EG2110.

e Fast copy designated portions of flash memory from one Rabbit-based board (the
master) to another (the slave) using the Rabbit Cloning Board.

Programming may also be initiated through the motherboard to which the RCM3000
series module is plugged in to since the Serial Port A (PC6 and PC7), SMODEO, SMODEL1,
and /RESET _IN are available on headers J1 and J2 (see Table 2).

Alternate Uses of the Serial Programming Port

All three clocked Serial Port A signals are available as

e asynchronous serial port

e an asynchronous serial port, with the clock line usable as a general CMOS input

The serial programming port may also be used as a serial port via the DIAG connector on
the serial programming cable.

In addition to Serial Port A, the Rabbit 3000 startup-mode (SMODEQO, SMODEL), status,
and reset pins are available on the serial programming port.

The two startup-mode pins determine what happens after a reset—the Rabbit 3000 is
either cold-booted or the program begins executing at address 0x0000.

The status pin is used by Dynamic C to determine whether a Rabbit microprocessor is
present. The status output has three different programmable functions:

1. It can be driven low on the first op code fetch cycle.
2. It can be driven low during an interrupt acknowledge cycle.
3. It can also serve as a general-purpose CMOS output.

The /RESET _IN pin is an external input that is used to reset the Rabbit 3000 and the
RCM3000 onboard peripheral circuits. The serial programming port can be used to force a
hard reset on the RCM3000 by asserting the /RESET _IN signal.

Refer to the Rabbit 3000 Microprocessor User’s Manual for more information.
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4.3 Serial Programming Cable

The programming cable is used to connect the serial programming port of the RCM3000
to a PC serial COM port. The programming cable converts the RS-232 voltage levels used
by the PC serial port to the CMOS voltage levels used by the Rabbit 3000.

When the PROG connector on the programming cable is connected to the RCM3000
serial programming port at header J3, programs can be downloaded and debugged over the
serial interface.

The DIAG connector of the programming cable may be used on header J3 of the RCM3000
with the RCM3000 operating in the Run Mode. This allows the programming port to be
used as a regular serial port.

4.3.1 Changing Between Program Mode and Run Mode

The RCM3000 is automatically in Program Mode when the PROG connector on the pro-
gramming cable is attached, and is automatically in Run Mode when no programming
cable is attached. When the Rabbit 3000 is reset, the operating mode is determined by the
status of the SMODE pins. When the programming cable’s PROG connector is attached,
the SMODE pins are pulled high, placing the Rabbit 3000 in the Program Mode. When the
programming cable’s PROG connector is not attached, the SMODE pins are pulled low,
causing the Rabbit 3000 to operate in the Run Mode.
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Short out pins 28—-32 on header J2, OR

Press RESET button (if using Prototyping Board), OR
Cycle power off/on

after removing or attaching programming cable.

RESET

Figure 9. Switching Between Program Mode and Run Mode

A program “runs” in either mode, but can only be downloaded and debugged when the
RCM3000 is in the Program Mode.

Refer to the Rabbit 3000 Microprocessor User’s Manual for more information on the pro-
gramming port and the programming cable.

4.3.2 Standalone Operation of the RCM3000

The RCM3000 must be programmed via the Prototyping Board or via a similar arrange-
ment on a customer-supplied board. Once the RCM3000 has been programmed success-
fully, remove the serial programming cable from the programming connector and reset the
RCM3000. The RCM3000 may be reset by cycling the power off/on or by pressing the
RESET button on the Prototyping Board. The RCM3000 module may now be removed
from the Prototyping Board for end-use installation.

CAUTION: Disconnect power to the Prototyping Board or other boards when removing
or installing your RCM3000 module to protect against inadvertent shorts across the
pins or damage to the RCM3000 if the pins are not plugged in correctly. Do not reapply
power until you have verified that the RCM3000 module is plugged in correctly.
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4.4 Other Hardware
4.4.1 Clock Doubler

The RCM3000 takes advantage of the Rabbit 3000 microprocessor’s internal clock dou-
bler. A built-in clock doubler allows half-frequency crystals to be used to reduce radiated
emissions. The 29.4 MHz frequency specified for the RCM3000 is generated using a
14.7456 MHz crystal. The clock doubler will not work for crystals with a frequency
above 26.7264 MHz.

The clock doubler may be disabled if 29.4 MHz clock speeds are not required. Disabling
the Rabbit 3000 microprocessor’s internal clock doubler will reduce power consumption
and further reduce radiated emissions. The clock doubler is disabled with a simple config-
uration macro as shown below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.
2. Add the line cLock DOUBLED=0 to always disable the clock doubler.

The clock doubler is enabled by default, and usually no entry is needed. If you need to
specify that the clock doubler is always enabled, add the line cLock DOUBLED=1 t0
always enable the clock doubler.

3. Click OK to save the macro. The clock doubler will now remain off whenever you are
in the project file where you defined the macro.

4.4.2 Spectrum Spreader

The Rabbit 3000 features a spectrum spreader, which helps to mitigate EMI problems. By
default, the spectrum spreader is on automatically, but it may also be turned off or set to a
stronger setting. The means for doing so is through a simple configuration macro as shown
below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.

2. Normal spreading is the default, and usually no entry is needed. If you need to specify nor-

mal spreading, add the line

ENABLE SPREADER=1
For strong spreading, add the line

ENABLE SPREADER=2
To disable the spectrum spreader, add the line

ENABLE SPREADER=0

NOTE: The strong spectrum-spreading setting is not recommended since it may limit

the maximum clock speed or the maximum baud rate. It is unlikely that the strong set-
ting will be used in a real application.

3. Click OK to save the macro. The spectrum spreader will now remain off whenever you are
in the project file where you defined the macro.

NOTE: Refer to the Rabbit 3000 Microprocessor User’s Manual for more information
on the spectrum-spreading setting and the maximum clock speed.
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4.5 Memory

45.1 SRAM

The RCM3000 can accept 128K to 512K of SRAM at U4.
4.5.2 Flash EPROM

The RCM3000 can accept 256K to 512K of flash EPROM.

NOTE: Rabbit Semiconductor recommends that any customer applications should not be
constrained by the sector size of the flash EPROM since it may be necessary to change
the sector size in the future.

Writing to arbitrary flash memory addresses at run time is also discouraged. Instead,
define a “user block” area to store persistent data. The functions writeUserBlock and
readUserBlock are provided for this.

A Flash Memory Bank Select jumper configuration option based on 0 € surface-mounted
resistors exists at header JP1 on the RCM3000 RabbitCore modules. This option, used in
conjunction with some configuration macros, allows Dynamic C to compile two different
co-resident programs for the upper and lower halves of the 256K flash in such a way that
both programs start at logical address 0000. This is useful for applications that require a
resident download manager and a separate downloaded program. See Technical Note 218,
Implementing a Serial Download Manager for a 256K Flash, for details.

4.5.3 Dynamic C BIOS Source Files

The Dynamic C BIOS source files handle different standard RAM and flash EPROM sizes
automatically.
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5. SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Rabbit Semiconductor controllers and
other controllers based on the Rabbit microprocessor. Chapter 4
provides the libraries and function calls related to the
RCM3000.

5.1 More About Dynamic C

Dynamic C has been in use worldwide since 1989. It is specially designed for program-
ming embedded systems, and features quick compile and interactive debugging. A com-
plete reference guide to Dynamic C is contained in the Dynamic C User’s Manual.

You have a choice of doing your software development in the flash memory or in the static
RAM included on the RCM3000. The flash memory and SRAM options are selected with
the Options > Project Options > Compiler menu.

The advantage of working in RAM is to save wear on the flash memory, which is limited
to about 100,000 write cycles. The disadvantage is that the code and data might not both
fit in RAM.

NOTE: An application can be developed in RAM, but cannot run standalone from RAM
after the programming cable is disconnected. All standalone applications can only run
from flash memory.

NOTE: Do not depend on the flash memory sector size or type. Due to the volatility of
the flash memory market, the RCM3000 and Dynamic C were designed to accommo-
date flash devices with various sector sizes.

The RCM3000 model has two 256K flash memories. By default, Dynamic C will use only
the first flash memory for program code in the RCM3000 model. Uncomment he BIOS
USE 2NDFLASH CODE macro to allow the second flash memory to hold any program
code that is in excess of the available memory in the first flash.
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Developing software with Dynamic C is simple. Users can write, compile, and test C and
assembly code without leaving the Dynamic C development environment. Debugging
occurs while the application runs on the target. Alternatively, users can compile a program
to an image file for later loading. Dynamic C runs on PCs under Windows 95 or later. Pro-
grams can be downloaded at baud rates of up to 460,800 bps after the program compiles.

Dynamic C has a number of standard features.
o Full-feature source and/or assembly-level debugger, no in-circuit emulator required.
¢ Royalty-free TCP/IP stack with source code and most common protocols.

e Hundreds of functions in source-code libraries and sample programs:

» Exceptionally fast support for floating-point arithmetic and transcendental functions.
» RS-232 and RS-485 serial communication.
» Analog and digital 1/O drivers.

» 12C, SPI, GPS, file system.
» LCD display and keypad drivers.
o Powerful language extensions for cooperative or preemptive multitasking

e Loader utility program to load binary images into Rabbit targets in the absence of
Dynamic C.

e Provision for customers to create their own source code libraries and augment on-line
help by creating “function description” block comments using a special format for
library functions.

e Standard debugging features:

» Breakpoints—Set breakpoints that can disable interrupts.
» Single-stepping—Step into or over functions at a source or machine code level, pC/OS-11 aware.

» Code disassembly—The disassembly window displays addresses, opcodes, mnemonics, and
machine cycle times. Switch between debugging at machine-code level and source-code level by
simply opening or closing the disassembly window.

» Wiatch expressions—Watch expressions are compiled when defined, so complex expressions
including function calls may be placed into watch expressions. Watch expressions can be updated
with or without stopping program execution.

» Register window—All processor registers and flags are displayed. The contents of general registers
may be modified in the window by the user.

» Stack window—shows the contents of the top of the stack.
» Hex memory dump—displays the contents of memory at any address.

» STDIO window—print£ outputs to this window and keyboard input on the host PC can be
detected for debugging purposes. print £ output may also be sent to a serial port or file.
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5.2 Dynamic C Functions
5.2.1 Digital I/0

The RCM3000 was designed to interface with other systems, and so there are no drivers
written specifically for the 1/0. The general Dynamic C read and write functions allow
you to customize the parallel 1/0 to meet your specific needs. For example, use

WrPortI (PEDDR, &PEDDRShadow, 0x00) ;

to set all the Port E bits as inputs, or use

WrPortI (PEDDR, &PEDDRShadow, OxFF);

to set all the Port E bits as outputs.

When using the auxiliary 1/0 bus on the Rabbit 3000 chip, add the line

#define PORTA AUX IO // required to enable auxiliary I/O bus

to the beginning of any programs using the auxiliary 1/0 bus.

The sample programs in the Dynamic C saMPLES/RcM3000 folder provide further
examples.

5.2.2 Serial Communication Drivers

Library files included with Dynamic C provide a full range of serial communications sup-
port. The Rs232.LIB library provides a set of circular-buffer-based serial functions. The
PACKET . LIB library provides packet-based serial functions where packets can be delimited
by the 9th bit, by transmission gaps, or with user-defined special characters. Both libraries
provide blocking functions, which do not return until they are finished transmitting or
receiving, and nonblocking functions, which must be called repeatedly until they are fin-
ished, allowing other functions to be performed between calls. For more information, see
the Dynamic C Function Reference Manual and Technical Note TN213, Rabbit Serial
Port Software.

5.2.3 TCPI/IP Drivers

The TCP/IP drivers are located in the LB\ TCcPIP folder. Complete information on these
libraries and the TCP/IP functions is provided in the Dynamic C TCP/IP User’s Manual.
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5.2.4 Prototyping Board Functions

The function described in this section is for use with the Prototyping Board. The source
code is in the ReM3000 . LIB library in the Dynamic C saMpLES\RcM3000 folder if you
need to modify it for your own board design.

Other generic functions applicable to all devices based on Rabbit microprocessors are
described in the Dynamic C Function Reference Manual.

5.2.5 Board Initialization

void brdInit (void);
Call this function at the beginning of your program. This function initializes Parallel Ports A through G
for use with the RCM3000/31/32XX Prototyping Board.

This function also sets any unused configurable port pins as outputs with a high output, and assumes that
only one RCM3000 module is installed in the MASTER position on the Prototyping Board.

RETURN VALUE
None.
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5.3 Upgrading Dynamic C

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web
sites www.rabbit.com/support/ for the latest patches, workarounds, and bug fixes.

The default installation of a patch or bug fix is to install the file in a directory (folder) dif-
ferent from that of the original Dynamic C installation. Rabbit Semiconductor recom-
mends using a different directory so that you can verify the operation of the patch without
overwriting the existing Dynamic C installation. If you have made any changes to the
BIOS or to libraries, or if you have programs in the old directory (folder), make these
same changes to the BIOS or libraries in the new directory containing the patch. Do not
simply copy over an entire file since you may overwrite a bug fix; of course, you may
copy over any programs you have written. Once you are sure the new patch works entirely
to your satisfaction, you may retire the existing installation, but keep it available to handle
legacy applications.

5.3.1 Upgrades

Dynamic C installations are designed for use with the board they are included with, and
are included at no charge as part of our low-cost kits. Dynamic C is a complete software
development system, but does not include all the Dynamic C features. Rabbit Semicon-
ductor also offers add-on Dynamic C modules containing the popular uC/OS-I1 real-time
operating system, as well as PPP, Advanced Encryption Standard (AES), and other select
libraries. In addition to the Web-based technical support included at no extra charge, a
one-year telephone-based technical support module is also available for purchase.
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6. USING THE TCP/IP FEATURES

6.1 TCP/IP Connections

Programming and development can be done with the RCM3000 RabbitCore modules without con-
necting the Ethernet port to a network. However, if you will be running the sample programs that use
the Ethernet capability or will be doing Ethernet-enabled development, you should connect the
RCM3000 module’s Ethernet port at this time.

Before proceeding you will need to have the following items.

¢ If you don’t have Ethernet access, you will need at least a 10Base-T Ethernet card
(available from your favorite computer supplier) installed in a PC.

e Two RJ-45 straight through Ethernet cables and a hub, or an RJ-45 crossover Ethernet
cable.

The Ethernet cables and a 10Base-T Ethernet hub are available from Rabbit Semiconduc-
tor in a TCP/IP tool kit. More information is available at www.rabbit.com.

1. Connect the AC adapter and the programming cable as shown in Chapter 2, “Hardware
Setup.”

2. Ethernet Connections

There are four options for connecting the RCM3000 module to a network for develop-
ment and runtime purposes. The first two options permit total freedom of action in
selecting network addresses and use of the “network,” as no action can interfere with
other users. We recommend one of these options for initial development.

e No LAN — The simplest alternative for desktop development. Connect the
RCM3000’s Ethernet port directly to the PC’s network interface card using an RJ-45
crossover cable. A crossover cable is a special cable that flips some connections
between the two connectors and permits direct connection of two client systems. A
standard RJ-45 network cable will not work for this purpose.

e Micro-LAN — Another simple alternative for desktop development. Use a small Eth-
ernet 10Base-T hub and connect both the PC’s network interface card and the
RCM3000’s Ethernet port to it, using standard network cables.
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The following options require more care in address selection and testing actions, as
conflicts with other users, servers and systems can occur:

LAN — Connect the RCM3000’s Ethernet port to an existing LAN, preferably one to
which the development PC is already connected. You will need to obtain IP addressing
information from your network administrator.

WAN — The RCM3000 is capable of direct connection to the Internet and other Wide
Area Networks, but exceptional care should be used with IP address settings and all
network-related programming and development. We recommend that development and
debugging be done on a local network before connecting a RabbitCore system to the
Internet.

TIP: Checking and debugging the initial setup on a micro-LAN is recommended before
connecting the system to a LAN or WAN.

The PC running Dynamic C through the serial port on the RCM3000 does not need to
be the PC with the Ethernet card.

3. Apply Power

Plug in the AC adapter. The RCM3000 module is now ready to be used.
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6.2 TCP/IP Primer on IP Addresses

Obtaining IP addresses to interact over an existing, operating, network can involve a num-
ber of complications, and must usually be done with cooperation from your ISP and/or
network systems administrator. For this reason, it is suggested that the user begin instead
by using a direct connection between a PC and the RCM3000 board using an Ethernet
crossover cable or a simple arrangement with a hub. (A crossover cable should not be con-
fused with regular straight through cables.)

In order to set up this direct connection, the user will have to use a PC without networking,
or disconnect a PC from the corporate network, or install a second Ethernet adapter and set
up a separate private network attached to the second Ethernet adapter. Disconnecting your
PC from the corporate network may be easy or nearly impossible, depending on how it is
set up. If your PC boots from the network or is dependent on the network for some or all
of its disks, then it probably should not be disconnected. If a second Ethernet adapter is
used, be aware that Windows TCP/IP will send messages to one adapter or the other,
depending on the IP address and the binding order in Microsoft products. Thus you should
have different ranges of IP addresses on your private network from those used on the cor-
porate network. If both networks service the same IP address, then Windows may send a
packet intended for your private network to the corporate network. A similar situation will
take place if you use a dial-up line to send a packet to the Internet. Windows may try to
send it via the local Ethernet network if it is also valid for that network.

The following IP addresses are set aside for local networks and are not allowed on the
Internet: 10.0.0.0 to 10.255.255.255, 172.16.0.0 to 172.31.255.255, and 192.168.0.0 to
192.168.255.255.

The RCM3000 board uses a 10Base-T type of Ethernet connection, which is the most
common scheme. The RJ-45 connectors are similar to U.S. style telephone connectors,
except they are larger and have 8 contacts.

An alternative to the direct connection using a crossover cable is a direct connection using
a hub. The hub relays packets received on any port to all of the ports on the hub. Hubs are
low in cost and are readily available. The RCM3000 board uses 10 Mbps Ethernet, so the
hub or Ethernet adapter must be either a 10 Mbps unit or a 10/100 unit that adapts to either
10 or 100 Mbps.

In a corporate setting where the Internet is brought in via a high-speed line, there are typi-
cally machines between the outside Internet and the internal network. These machines
include a combination of proxy servers and firewalls that filter and multiplex Internet traf-
fic. In the configuration below, the RCM3000 board could be given a fixed address so any
of the computers on the local network would be able to contact it. It may be possible to
configure the firewall or proxy server to allow hosts on the Internet to directly contact the
controller, but it would probably be easier to place the controller directly on the external
network outside of the firewall. This avoids some configuration complications by sacrific-
ing some security.
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If your system administrator can give you an Ethernet cable along with its IP address, the
netmask and the gateway address, then you may be able to run the sample programs with-
out having to setup a direct connection between your computer and the RCM3000 board.
You will also need the IP address of the nameserver, the name or IP address of your mail
server, and your domain name for some of the sample programs.
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6.3 IP Addresses Explained

IP (Internet Protocol) addresses are expressed as 4 decimal numbers separated by periods,
for example:

216.103.126.155
10.1.1.6

Each decimal number must be between 0 and 255. The total IP address is a 32-bit number
consisting of the 4 bytes expressed as shown above. A local network uses a group of adja-

cent IP addresses. There are always 2N IP addresses in a local network. The netmask (also
called subnet mask) determines how many IP addresses belong to the local network. The
netmask is also a 32-bit address expressed in the same form as the IP address. An example
netmask is:

255.255.255.0

This netmask has 8 zero bits in the least significant portion, and this means that 28
addresses are a part of the local network. Applied to the IP address above
(216.103.126.155), this netmask would indicate that the following IP addresses belong to
the local network:

216.103.126.0
216.103.126.1
216.103.126.2
etc.
216.103.126.254
216.103.126.255

The lowest and highest address are reserved for special purposes. The lowest address
(216.102.126.0) is used to identify the local network. The highest address
(216.102.126.255) is used as a broadcast address. Usually one other address is used for the
address of the gateway out of the network. This leaves 256 - 3 = 253 available IP
addresses for the example given.
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6.4 How IP Addresses are Used

The actual hardware connection via an Ethernet uses Ethernet adapter addresses (also
called MAC addresses). These are 48-bit addresses and are unique for every Ethernet
adapter manufactured. In order to send a packet to another computer, given the IP address
of the other computer, it is first determined if the packet needs to be sent directly to the
other computer or to the gateway. In either case, there is an IP address on the local net-
work to which the packet must be sent. A table is maintained to allow the protocol driver
to determine the MAC address corresponding to a particular IP address. If the table is
empty, the MAC address is determined by sending an Ethernet broadcast packet to all
devices on the local network asking the device with the desired IP address to answer with
its MAC address. In this way, the table entry can be filled in. If no device answers, then
the device is nonexistent or inoperative, and the packet cannot be sent.

IP addresses are arbitrary and can be allocated as desired provided that they don’t conflict
with other IP addresses. However, if they are to be used with the Internet, then they must
be numbers that are assigned to your connection by proper authorities, generally by dele-
gation via your service provider.

Each RCM3000 RabbitCore module has its own uniqgue MAC address, which consists of
the prefix 0090C2 followed by the code that appears on the label affixed to the RCM3000
module. For example, a MAC address might be 0090C2C002C0.

TIP: You can always verify the MAC address on your board by running the sample pro-
gram DISPLAY MAC.C from the SAMPLES\TCPIP folder.
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6.5 Dynamically Assigned Internet Addresses

In many instances, there are no fixed IP addresses. This is the case when, for example, you
are assigned an IP address dynamically by your dial-up Internet service provider (ISP) or
when you have a device that provides your IP addresses using the Dynamic Host Configu-
ration Protocol (DHCP). The RCM3000 RabbitCore modules can use such IP addresses to
send and receive packets on the Internet, but you must take into account that this IP
address may only be valid for the duration of the call or for a period of time, and could be
a private IP address that is not directly accessible to others on the Internet. These private
address can be used to perform some Internet tasks such as sending e-mail or browsing the
Web, but usually cannot be used to participate in conversations that originate elsewhere on
the Internet. If you want to find out this dynamically assigned IP address, under Windows
98 you can run the winipc £g program while you are connected and look at the interface
used to connect to the Internet.

Many networks use private IP addresses that are assigned using DHCP. When your com-
puter comes up, and periodically after that, it requests its networking information from a
DHCP server. The DHCP server may try to give you the same address each time, but a
fixed IP address is usually not guaranteed.

If you are not concerned about accessing the RCM3000 from the Internet, you can place
the RCM3000 on the internal network using a private address assigned either statically or
through DHCP.
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6.6 Placing Your Device on the Network

In many corporate settings, users are isolated from the Internet by a firewall and/or a
proxy server. These devices attempt to secure the company from unauthorized network
traffic, and usually work by disallowing traffic that did not originate from inside the net-
work. If you want users on the Internet to communicate with your RCM3000, you have
several options. You can either place the RCM3000 directly on the Internet with a real
Internet address or place it behind the firewall. If you place the RCM3000 behind the fire-
wall, you need to configure the firewall to translate and forward packets from the Internet
to the RCM3000.
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6.7 Running TCP/IP Sample Programs

We have provided a number of sample programs demonstrating various uses of TCP/IP for
networking embedded systems. These programs require you to connect your PC and the
RCM3000 board together on the same network. This network can be a local private net-
work (preferred for initial experimentation and debugging), or a connection via the Internet.

RCM3000
Board RCM3000
Board
User’s PC e n
/( Ethernet /
Ethernet cables )
crossover m IZI/II_I . To additional
cable Hub \/ network
Direct Connection . : ele.ments
(network of 2 computers) Direct Connection Using a Hub
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6.8 How to Set IP Addresses in the Sample Programs

With the introduction of Dynamic C 7.30 we have taken steps to make it easier to run
many of our sample programs. Instead of theMmy 1P ADDRESS and other macros, you will
see a TCPCONFIG macro. This macro tells Dynamic C to select your configuration from a
list of default configurations. You will have three choices when you encounter a sample
program with the TCPCONFIG macro.

1. You can replace the TcpcoNFIG macro with individual MY IP ADDRESS,
MY NETMASK, MY GATEWAY, and MY NAMESERVER Macros in each program.

2. You can leave TcPCONFIG at the usual default of 1, which will set the IP configurations
t010.10.6.100, the netmask to 255.255.255. 0, and the nameserver and gateway
to10.10.6.1. If youwould like to change the default values, for example, to use an IP
addressof 10.1.1.2 for the RCM3000 board, and 10.1. 1.1 for your PC, you can edit
the values in the section that directly follows the “General Configuration” comment in
the Tcp_conNrFIe.LIB library. You will find this library in the LIB/TCPIP directory.

3. You can create a CUSTOM CONFIG.LIB library and use a TCPCONFIG value greater
than 100. Instructions for doing this are at the beginning of the Tcp coNFIG.LIB file.

There are some other “standard” configurations for TcPcoNFIG that let you select differ-
ent features such as DHCP. Their values are documented at the top of the
TCP_CONFIG.LIB library. More information is available in the Dynamic C TCP/IP
User’s Manual.

IP Addresses Before Dynamic C 7.30

Most of the sample programs such as shown in the example below use macros to define the
IP address assigned to the board and the IP address of the gateway, if there is a gateway.

#define MY IP ADDRESS "10.10.6.170"
#define MY NETMASK "255.255.255.0"
#define MY GATEWAY "10.10.6.1"
#define MY NAMESERVER "10.10.6.1"

In order to do a direct connection, the following IP addresses can be used for the RCM3000:

#define MY IP ADDRESS "10.1.1.2"

#define MY NETMASK "255.255.255.0"

// #define MY GATEWAY "10.10.6.1"

// #define MY NAMESERVER "10.10.6.1"
In this case, the gateway and nameserver are not used, and are commented out. The IP
address of the board is defined to be 10.1.1.2. The IP address of your PC can be defined

as10.1.1.1.
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6.9 How to Set Up Your Computer’s IP Address for Direct Connect

When your computer is connected directly to the RCM3000 board via an Ethernet connec-
tion, you need to assign an IP address to your computer. To assign the PC the address
10.10.6.101 with the netmask 255.255.255. 0, do the following.

Click on Start > Settings > Control Panel to bring up the Control Panel, and then dou-
ble-click the Network icon. Depending on which version of Windows you are using, look
for the TCP/IP Protocol/Network > Dial-Up Connections/Network line or tab. Double-
click on this line or select Properties or Local Area Connection > Properties to bring
up the TCP/IP properties dialog box. You can edit the IP address and the subnet mask
directly. (Disable “obtain an IP address automatically.”) You may want to write down the
existing values in case you have to restore them later. It is not necessary to edit the gate-
way address since the gateway is not used with direct connect.

RCM3000
IP 10.10.6.101 Board
Netmask
255.255.255.0

User’s PC

Ethernet
crossover
cable

Direct Connection PC to RCM3000 Board
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6.10 Run the PINGME.C Sample Program

Connect the crossover cable from your computer’s Ethernet port to the RCM3000 board’s
RJ-45 Ethernet connector. Open this sample program from the SAMPLES\TCPIP\ICMP
folder, compile the program, and start it running under Dynamic C. When the program
starts running, the green LNK light on the RCM3000 board should be on to indicate an
Ethernet connection is made. (Note: If the LNK light does not light, you may not have a
crossover cable, or if you are using a hub perhaps the power is off on the hub.)

The next step is to ping the board from your PC. This can be done by bringing up the MS-
DOS window and running the pingme program:

ping 10.10.6.100
or by Start > Run

and typing the entry
ping 10.10.6.100
Notice that the red ACT light flashes on the RCM3000 board while the ping is taking

place, and indicates the transfer of data. The ping routine will ping the board four times
and write a summary message on the screen describing the operation.

6.11 Running More Sample Programs With Direct Connect

The sample programs discussed here are in the Dynamic C SAMPLES\RCM3000\TCPIP\
folder.

e BROWSELED.C—This program demonstrates a basic controller running a Web page.
Two “LEDs” are created on the Web page, with two buttons to toggle them. Users can
change the status of the lights from the Web browser. The LEDs on the Prototyping
Board match the ones on the Web page. As long as you have not modified the
TCPCONFIG 1 macro inthe sample program, enter the following server address in your
Web browser to bring up the Web page served by the sample program.

http://10.10.6.100.
Otherwise use the TCP/IP settings you entered in the TCP_CONFIG.LIB library.

e ECHOCLIENT.C—This program demonstrates a basic client that will send a packet and
wait for the connected server to echo it back. After every number of sends and receives,
transfer times are shown in the STDIO window.

Use ECHO SERVER.C to program a server controller.

e ECHOSERVER.C—This program demonstrates This program demonstrates a basic
server that will echo back any data sent from a connected client.

Use ECHO CLIENT.C to program a client controller.

e ENET AD.C—This program demonstrates Ethernet communication between two sin-
gle-board computers. The program sends an A/D voltage value to the second controller
via Ethernet for display.

Use ENET MENU. C to program the other single-board computer.
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e ENET MENU.C—This program demonstrates how to implement a menu system using a
highlight bar on a graphic LCD display and to communicate it to another single-board
computer via Ethernet.

Use ENET AD.C to program the other single-board computer with analog inputs and
outputs.

e MBOXDEMO.C—Implements a Web server that allows e-mail messages to be entered
and then shown on the LCD/keypad module.

e sMTP.C—This program allows you to send an E-mail when a switch on the Prototyp-
ing Board is pressed. Follow the instructions included with the sample program.

e PINGLED.C—This program demonstrates ICMP by pinging a remote host. It will flash
LEDs DS1 and DS2 on the Prototyping Board when a ping is sent and received.

6.12 Where Do | Go From Here?

NOTE: If you purchased your RCM3000 through a distributor or through a Rabbit Semi-
conductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:
e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Rabbit Semiconductor Technical Bulletin Board at
www.rabbit.com/support/bb/.

e Use the Technical Support e-mail form at www.rabbit.com/support/.
If the sample programs ran fine, you are now ready to go on.
Additional sample programs are described in the Dynamic C TCP/IP User’s Manual.

Please refer to the Dynamic C TCP/IP User’s Manual to develop your own applications.
An Introduction to TCP/IP provides background information on TCP/IP, and is available
on the CD and on our \Web site.
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APPENDIX A. RCM3000 SPECIFICATIONS

Appendix A provides the specifications for the RCM3000, and
describes the conformal coating.
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A.l1 Electrical and Mechanical Characteristics
Figure A-1 shows the mechanical dimensions for the RCM3000.
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Figure A-1. RCM3000 Dimensions

NOTE: All measurements are in inches followed by millimeters enclosed in parentheses.
All dimensions have a manufacturing tolerance of £0.01" (0.25 mm).
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It is recommended that you allow for an “exclusion zone” of 0.04" (1 mm) around the
RCM3000 in all directions when the RCM3000 is incorporated into an assembly that
includes other printed circuit boards. This “exclusion zone” that you keep free of other
components and boards will allow for sufficient air flow, and will help to minimize any
electrical or electromagnetic interference between adjacent boards. An “exclusion zone
of 0.08" (2 mm) is recommended below the RCM3000 when the RCM3000 is plugged
into another assembly using the shortest connectors for headers J1 and J2. Figure A-2
shows this “exclusion zone.”
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(1) (47.0) 1)

Figure A-2. RCM3000 “Exclusion Zone”
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Table A-1 lists the electrical, mechanical, and environmental specifications for the RCM3000.

Table A-1. RabbitCore RCM3000 Specifications

Feature

RCM3000 RCM3010

Microprocessor

Rabbit 3000 at 29.4 MHz

EMI Reduction

Spectrum spreader for reduced EMI (radiated emissions)

Ethernet Port

10/100-compatible with 10Base-T interface, RJ-45, 2 LEDs

Flash Memory

512K (2 x 256K) 256K

SRAM

512K 128K

Backup Battery

Connection for user-supplied backup battery (to support RTC and SRAM)

General-Purpose 1/0

52 parallel digital 1/0 lines:
« 44 configurable 1/0,
« 4 fixed inputs,
« 4 fixed outputs

Additional Digital Inputs

2 startup mode, reset in

Additional Digital Outputs

Status, reset out

Aucxiliary 1/0 Bus

8 data lines and 6 address lines (shared with 1/0) plus 1/0 read/write

6 shared high-speed, CMOS-compatible ports:

« 6 configurable as asynchronous (with IrDA),
4 as clocked serial (SPI), and 2 as

Serial Ports SDLC/HDLC (with IrDA)
« 1 asynchronous serial port dedicated for
programming
« support for MIR/SIR IrDA transceiver
Serial Rate Max. asynchronous baud rate = CLK/8

Slave Interface

A slave port allows the RCM3100 to be used as a master or as an
intelligent peripheral device with Rabbit-based or any other type of
processor

Real-Time Clock

Yes

Timers

Ten 8-bit timers (6 cascadable from the first),
one 10-bit timer with 2 match registers

Watchdog/Supervisor

Yes

Pulse-Width Modulators

10-bit free-running counter and four pulse-width registers

Input Capture

2- channel input capture can be used to time input signals
from various port pins

Quadrature Decoder

2-channel quadrature decoder accepts inputs
from external incremental encoder modules

Power

3.15Vt03.45VDC
150mA @ 3.3V
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Table A-1. RabbitCore RCM3000 Specifications (continued)

Feature RCM3000 RCM3010

Operating Temperature —40°C to +70°C

Humidity 5% to 95%, noncondensing

Connectors (for connection to

headers J4 and J5) Two 2 x 17, 2 mm pitch

1.850" x 2.725" x 0.86"

Board Size (47 mm x 69 mm x 22 mm)

A.1.1 Headers

The RCM3000 uses headers at J1 and J2 for physical connection to other boards. J1 and J2
are 2 x 17 SMT headers with a 2 mm pin spacing. J3, the programming port, isa 2 x 5
header with a 2 mm pin spacing.

Figure A-3 shows the layout of another board for the RCM3000 to be plugged into. These
values are relative to the mounting hole.
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\
i \
‘ 0.100 dia \
| @5) j
7
‘ \
- —_— — 0.020 sq typ i
AN o
! 0.314 : 0.079 ‘
‘ (8.0) [~ (2.3) J1 \
S R TR B i S _d

Figure A-3. User Board Footprint for RCM3000

A.1.2 Physical Mounting

A 9/32” (7 mm) standoff with a 2-56 screw is recommended to attach the RCM3000 to a
user board at the hole position shown in Figure A-3. Either use plastic hardware, or use
insulating washers to keep any metal hardware from shorting out signals on the RCM3000.
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A.2 Bus Loading

You must pay careful attention to bus loading when designing an interface to the
RCM3000. This section provides bus loading information for external devices.

Table A-2 lists the capacitance for the various RCM3000 1/O ports.

Table A-2. Capacitance of Rabbit 3000 I/O Ports

Input Output
I/O Ports Capacitance Capacitance
(PF) (PF)
Parallel Ports A to G 12 14

Table A-3 lists the external capacitive bus loading for the various RCM3000 output ports.

Be sure to add the loads for the devices you are using in your custom system and verify
that they do not exceed the values in Table A-3.

Table A-3. External Capacitive Bus Loading -40°C to +70°C

Output Port Clock Speed Maximum External
i (MHz2) Capacitive Loading (pF)

All 1/0 lines with clock
doubler enabled 29.4 30-70

All 1/O lines with clock
doubler disabled 14.7456 100
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Figure A-4 shows a typical timing diagram for the Rabbit 3000 microprocessor external
1/0 read and write cycles.

Figure A-4. External I/0O Read and Write Cycles—No Extra Wait States

NOTE: /IOCSx can be programmed to be active low (default) or active high.

Memory Read (no wait states)

T T2
CLK - L
A[19:0] __X valid X
~ <_Tadr
ICSx | YAl
2l Tosx 21 Tosx
10]= 1 e
T X—> <« —>| <T X
% Tsetup-> %
D[7:0]
Thold
Memory Write (no extra wait states)
T —f—Tw—f—1—f
CLK —
Al19:0] — X valid X
e <_Tadr
ICSx | /k
> Tosx Tesx?| 1€
IWEX )L k T
g <_TWEx TWEx_> <

D[7:0] ( valid )‘~
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Table A-4 lists the delays in gross memory access time for Vpp = 3.3 V.

Table A-4. Data and Clock Delays Vpp £#10%, Temp, -40°C—+85°C (maximum)

Clock to Address Output Delay Spectrum Spreader Delay
(ns) Data Setup (ns)
VDD Time Delay
(ns) Normal Strong

F F F
30p e0p 0p dbl/no dbl | dbl/no dbl

3.3 6 8 1 1 3/4.5 4.5/9

The measurements are taken at the 50% points under the following conditions.
e T=-40°Cto85°C, V =Vpp +10%

¢ Internal clock to nonloaded CLK pin delay <1 ns @ 85°C/3.0 V

The clock to address output delays are similar, and apply to the following delays.
e T.q4pr the clock to address delay

e Tcsy the clock to memory chip select delay

* T\wex the clock to memory write strobe delay

* Tocsx the clock to 1/0 chip select delay

* T,0rp, the clock to I/O read strobe delay

e T,owr the clock to I/0 write strobe delay

e Tguren, the clock to I/0 buffer enable delay

The data setup time delays are similar for both Tget,, and Tpgyg.

When the spectrum spreader is enabled with the clock doubler, every other clock cycle is
shortened (sometimes lengthened) by a maximum amount given in the table above. The
shortening takes place by shortening the high part of the clock. If the doubler is not
enabled, then every clock is shortened during the low part of the clock period. The maxi-
mum shortening for a pair of clocks combined is shown in the table.
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A.3 Rabbit 3000 DC Characteristics

Table A-5 outlines the DC characteristics for the Rabbit 3000 at 3.3 V over the recom-
mended operating temperature range from T, = -55°C to +125°C, Vpp =3.0Vt0 3.6 V.

Note that while the Rabbit 3000 is rated to operate over a voltage range from 3.0-3.6 V,

the RCM3000 has a more restrictive operating voltage range of 3.15-3.45 V DC.

Table A-5. 3.3 Volt DC Characteristics

Symbol Parameter Test Conditions Min Typ Max | Units
iy Input Leakage High Vin=Vbps Vpp =33V 1 HA
Input Leakage Low _ _
| VN =Vss, Vpp =33V |-
I (no pull-up) IN = Vss: VDD 1 HA
Vin = Vpp Or Vg,
| - -
oz Output Leakage (no pull-up) Vpp =33V 1 1 HA
ViL CMOS Input Low Voltage 0.3%xVpp |V
Vi CMOS Input High Voltage 0.7 x Vpp \Y;
V1 CMOS Switching Threshold | Vpp =3.3V, 25°C 1.65 V
VoL Low-Level Output Voltage |l =6 mMA 0.4 \V,
Vou High-Level Output Voltage | lon =6 MA 0.7xVpp \Y
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A.4 1/0O Buffer Sourcing and Sinking Limit

Unless otherwise specified, the Rabbit 3000 I/O buffers are capable of sourcing and sink-
ing 6.8 mA of current per pin at full AC switching speed. Full AC switching assumes a
29.4 MHz CPU clock and capacitive loading on address and data lines of less than 70 pF
per pin. The maximum Vcc is 3.6 V, and the absolute maximum operating voltage on all
parallel /0 is5.5 V.

Table A-6 shows the AC and DC output drive limits of the parallel 1/0 buffers when the
Rabbit 3000 is used in the RCM3000.

Table A-6. I/O Buffer Sourcing and Sinking Capability

Output Drive (Full AC Switching)
Sourcing/Sinking Limits

Pin Name (mA)
Sourcing Sinking
All data, address, and 1/0
lines with clock doubler 6.8 6.8
enabled

Under certain conditions, the maximum instantaneous AC/DC sourcing or sinking current
may be greater than the limits outlined in Table A-6. The maximum AC/DC sourcing cur-
rent can be as high as 12.5 mA per buffer as long as the number of sourcing buffers does
not exceed three per Vpp or Vgg pad, or up to six outputs between pads. Similarly, the
maximum AC/DC sinking current can be as high as 8.5 mA per buffer as long as the num-
ber of sinking buffers does not exceed three per Vpp or Vgg pad, or up to six outputs
between pads. The Vpp bus can handle up to 35 mA, and the Vgg bus can handle up to

28 mA. All these analyses were measured at 100°C.
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A.5 Conformal Coating

The areas around the 32 kHz real-time clock crystal oscillator has had the Dow Corning
silicone-based 1-2620 conformal coating applied. The conformally coated area is shown
in Figure A-5. The conformal coating protects these high-impedance circuits from the
effects of moisture and contaminants over time.

Y1

z| Conformally coated
~ area

uuuuu

Figure A-5. RCM3000 Areas Receiving Conformal Coating

Any components in the conformally coated area may be replaced using standard soldering
procedures for surface-mounted components. A new conformal coating should then be
applied to offer continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Technical Note 303, Con-
formal Coatings.
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A.6 Jumper Configurations

Figure A-6 shows the header locations used to configure the various RCM3000 options
via jumpers.

Table A-7 lists the configuration options.

Top Side

Bottom Side

JPSIj

Figure A-6. Location of RCM3000 Configurable Positions

Table A-7. RCM3000 Jumper Configurations

Header Description Pins Connected Factory
Default
1-2 | Normal Mode X
JP1 Flash Memory Bank Select
2-3 |Bank Mode
1-2 | 128K/256K X
JP2 Flash Memory Size
2-3 | 512K
1-2 | 128K/256K RCM3000
JP3 Flash Memory Size
2-3 | 512K
1-2 | 128K RCM3010
JP4 | SRAM Size
2-3 | 512K RCM3000
1-2 | Buffer disabled
JP5 | Auxiliary 1/O data bus
2-3 | Buffer enabled X

NOTE: The jumper connections are made using 0 Q surface-mounted resistors.
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APPENDIX B. PROTOTYPING BOARD

Appendix B describes the features and accessories of the Proto-
typing Board, and explains the use of the Prototyping Board to
demonstrate the RCM3000 and to build prototypes of your own
circuits.
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B.1 Introduction

The Prototyping Board included in the Development Kit makes it easy to connect an
RCM3000 module to a power supply and a PC workstation for development. It also pro-
vides some basic 1/0 peripherals (switches and LEDSs), as well as a prototyping area for

more advanced hardware development.

For the most basic level of evaluation and development, the Prototyping Board can be

used without modification.

As you progress to more sophisticated experimentation and hardware development, modi-
fications and additions can be made to the board without modifying or damaging the

RCM3000 module itself.

The Prototyping Board is shown below in Figure B-1, with its main features identified.
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Figure B-1. RCM30/31/32XX Prototyping Board
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B.1.1 Prototyping Board Features

Power Connection—A power-supply jack and a 3-pin header are provided for con-
nection to the power supply. Note that the 3-pin header is symmetrical, with both outer
pins connected to ground and the center pin connected to the raw V+ input. The cable
of the AC adapter provided with the North American version of the Development Kit
ends in a plug that connects to the power-supply jack. The header plug leading to bare
leads provided for overseas customers can be connected to the 3-pin header in either
orientation.

Users providing their own power supply should ensure that it delivers 8-24 V DC at
8 W. The voltage regulators will get warm while in use.

Regulated Power Supply—The raw DC voltage provided at the POWER IN jack is
routed to a 5 V switching voltage regulator, then to a separate 3.3 V linear regulator.
The regulators provide stable power to the RCM3000 module and the Prototyping
Board.

Power LED—The power LED lights whenever power is connected to the Prototyping
Board.

Reset Switch—A momentary-contact, normally open switch is connected directly to the
RCM3000’s /RESET_IN pin. Pressing the switch forces a hardware reset of the system.

I/O Switches and LEDs—Two momentary-contact, normally open switches are con-
nected to the PGO and PG1 pins of the master RCM3000 module and may be read as
inputs by sample applications.

Two LEDs are connected to the PG6 and PG7 pins of the master module, and may be
driven as output indicators by sample applications.

Prototyping Area—A generous prototyping area has been provided for the installation
of through-hole components. +3.3 V, +5 V, and Ground buses run around the edge of
this area. Several areas for surface-mount devices are also available. (Note that there
are SMT device pads on both top and bottom of the Prototyping Board.) Each SMT pad
is connected to a hole designed to accept a 30 AWG solid wire.

Master Module Connectors—A set of connectors is pre-wired to permit installation
of the first RCM3000, RCM3100, or RCM3200 module that serves as the primary or
“master module.”

Slave Module Connectors—A second set of connectors is pre-wired to permit instal-
lation of a second, slave RCM3000, RCM3100, or RCM3200 module. This capability
is reserved for future use, although the schematics in this manual contain all of the
details an experienced developer will need to implement a master-slave system.

Module Extension Headers—The complete pin sets of both the MASTER and
SLAVE RabbitCore modules are duplicated at these two sets of headers. Developers
can solder wires directly into the appropriate holes, or, for more flexible development,
26-pin header strips can be soldered into place. See Figure B-4 for the header pinouts.
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RS-232—Two 3-wire or one 5-wire RS-232 serial port are available on the Prototyping
Board. Refer to the Prototyping Board schematic (090-0137) for additional details.

A 10-pin 0.1-inch spacing header strip is installed at J5 to permit connection of a ribbon
cable leading to a standard DE-9 serial connector.

Current Measurement Option—Jumpers across pins 1-2 and 5-6 on header JP1 can
be removed and replaced with an ammeter across the pins to measure the current drawn
from the +5 V or the +3.3 V supplies, respectively.

Motor Encoder—A motor/encoder header is provided at header J6 for future use.

LCD/Keypad Module—our’s LCD/keypad module may be plugged in directly to
headers J7, J8, and J10.
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B.2 Mechanical Dimensions and Layout

Figure B-2 shows the mechanical dimensions and layout for the Prototyping Board.
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Figure B-2. RCM30/31/32XX Prototyping Board Dimensions

" ot 0000000000000000000000000000000000J] Le 38
REAT] F T oo
0000000000000000000000000000000000] =
o 0000000000000000000000000000000000J]

Dﬁﬂ Rei0y 2
oGOk ~[O0 | g 0 e DOOOL___ _ DOOOCI T ;

8 : 8 8 - ROV ETHERNET CORE HODULE fi 11

Ols O Olror [ R

= oo e

Of O Ol =

Ofre O Ofpes ::z:

ol 00 =

1S s —_—

Ofre (ele]

O O O

O Ol O Olfprs

O O Ol

Olre O Ol ! =] RCM30/31/32XX SERIES w3

Ol O Ol Rovzin 5| RCM2J8 R‘ﬂ EW PROTOTYPING BOARD
el ONQrs 0 O RESET I =, = % 24
L - = EEEE OEEE
A oy 5O) L o k 4y [ - ( v

w0 __
|0.475 3.40 2.70 0205
(12) (86) (69) (5)
6.775
(172)

NOTE: All measurements are in inches followed by millimeters enclosed in parentheses.
All dimensions have a manufacturing tolerance of £0.01" (0.25 mm).

User’s Manual

65



Table B-1 lists the electrical, mechanical, and environmental specifications for the Proto-

typing Board.

Table B-1. RCM30/31/32XX Prototyping Board Specifications

Parameter

Specification

Board Size

5.30" x 6.775" x 1.00" (135 mm x 172 mm x 25 mm)

Operating Temperature

—-20°C to +60°C

Humidity

5% to 95%, noncondensing

Input Voltage

8V1t024VDC

Maximum Current Draw

(including user-added circuits)

800 mA max. for +3.3 V supply,
1 A total +3.3 V and +5 V combined

Prototyping Area

2.0" x 3.5" (50 mm x 90 mm) throughhole, 0.1" spacing,

additional space for SMT components

Standoffs/Spacers

5, accept 4-40 x 3/8 screws

B.3 Power Supply

The RCM3000 requires a regulated 3.3 VV = 0.15 VV DC power source to operate. Depend-
ing on the amount of current required by the application, different regulators can be used

to supply this voltage.

The Prototyping Board has an onboard +5 V switching power regulator from which a
+3.3 V linear regulator draws its supply. Thus both +5 V and +3.3 V are available on the

Prototyping Board.

The Prototyping Board itself is protected against reverse polarity by a Shottky diode at D2

as shown in Figure B-3.
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Figure B-3. Prototyping Board Power Supply
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B.4 Using the Prototyping Board

The Prototyping Board is actually both a demonstration board and a prototyping board.
As a demonstration board, it can be used to demonstrate the functionality of the RCM3000
right out of the box without any modifications to either board. There are no jumpers or dip
switches to configure or misconfigure on the Prototyping Board so that the initial setup is
very straightforward.

The Prototyping Board comes with the basic components necessary to demonstrate the
operation of the RCM3000. Two LEDs (DS1 and DS2) are connected to PG6 and PG?7,
and two switches (S2 and S3) are connected to PG1 and PGO to demonstrate the interface
to the Rabbit 3000 microprocessor. Reset switch S1 is the hardware reset for the
RCM3000.

The Prototyping Board provides the user with RCM3000 connection points brought out con-
veniently to labeled points at headers J2 and J4 on the Prototyping Board. Small to medium
circuits can be prototyped using point-to-point wiring with 20 to 30 AWG wire between the
prototyping area and the holes at locations J2 and J4. The holes are spaced at 0.1" (2.5 mm),
and 40-pin headers or sockets may be installed at J2 and J4. The pinouts for locations J2 and
J4, which correspond to headers J1 and J2, are shown in Figure B-4.

J2 J4
GND |0 o|n.c. PD1|o ©o|PDO
GND |0 o] +3.3V PD7|c ©o|PD6
VBAT EXT |o o | VRAM PD3|c ©o|PD2
/RESET_IN [ o ©o| SMODE1 PD5|c o |PD4
SMODEO | o o | /IORD PG3 |0 o|PG2
IOWR | & o | PG4 PG1|o o|PGO
PG5 |0 o|PG6 PC7 |2 =|PC6
PG7 |0 o|PEO PC5|2 o |PC4
PE1|o ol PE3 PC3|o o|PC2
PE4 |0 ©o| PE5 PC1|o ©|PCO
PE6 |2 o| PE7 PFO |2 o |PF1
PF7 |c ©o| PF6 PF2|= ©o|PF3
PF5|c o| PF4 PAO |2 ©|PA1
PB7 |0 ©| PB6 PA2 |© ©|PA3
PB5 |0 0| PB4 PA4 |© o |PA5
PB3 |0 ©o|PB2 PA6 | = ©|PA7
PBO | M| /RES STATUS |© B | GND
n.c. = not connected

Figure B-4. RCM30/31/32XX Prototyping Board Pinout
(Top View)

The small holes are also provided for surface-mounted components that may be installed
around the prototyping area.

There is a 2.0" x 3.5" through-hole prototyping space available on the Prototyping Board.
+3.3V, +5V, and GND traces run along the edge of the Prototyping Board for easy access.
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B.4.1 Adding Other Components

There are pads that can be used for surface-mount prototyping involving SOIC devices.
There is provision for seven 16-pin devices (six on one side, one on the other side). There
are 10 sets of pads that can be used for 3- to 6-pin SOT23 packages. There are also pads
that can be used for SMT resistors and capacitors in an 0805 SMT package. Each compo-
nent has every one of its pin pads connected to a hole in which a 30 AWG wire can be sol-
dered (standard wire wrap wire can be soldered in for point-to-point wiring on the
Prototyping Board). Because the traces are very thin, carefully determine which set of
holes is connected to which surface-mount pad.

B.4.2 Measuring Current Draw

The Prototyping Board has a current-measurement feature available on header JP1. Nor-
mally, a jumper connects pins 1-2 and pins 5-6 on header JP1, which provide jumper con-
nections for the +5 V and the +3.3 V regulated voltages respectively. You may remove a
jumper and place an ammeter across the pins instead, as shown in the example in

Figure B-5, to measure the current being drawn.
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Figure B-5. Prototyping Board Current-Measurement Option
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B.4.3 Other Prototyping Board Modules and Options

With the RCM3000 plugged into the MASTER slots, it has full access to the RS-232 trans-
ceiver, and can act as the “master” relative to another RabbitCore RCM3000, RCM3100,
or RCM3200 plugged into the SLAVE slots, which acts as the “slave.”

An optional LCD/keypad module is available that can be mounted on the Prototyping
Board. Refer to Appendix C, “LCD/Keypad Module,” for complete information.

The RCM3100 has a 2-channel quadrature decoder and a 10-bit free-running PWM
counter with four pulse-width registers. These features allow the RCM3100 to be used ina
motor control application, although our does not offer the drivers or a compatible stepper
motor control board at this time.

The Prototyping Board has a header at J6 to which a customer-developed motor encoder
may be connected. Figure B-6 shows the motor encoder pinout at header J6.

J6
PFO (m o| PF1
PF2 |0 o|PF3
PF4 |o o|PF5
PF6 |0 o |PF7
+5V |2 2| GND

Figure B-6. Prototyping Board Motor Encoder
Connector Pinout

Refer to Appendix E, “Motor Control Features,” for complete information on using the
Rabbit 3000’s Parallel Port F in conjunction with this application.
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B.5 Use of Rabbit 3000 Parallel Ports

Table B-2 lists the Rabbit 3000 parallel ports and their use for the RCM30/31/32XX
Prototyping Board.

Table B-2. RCM30/31/32XX Prototyping Board
Use of Rabbit 3000 Parallel Ports

Port I/O Use Initial State
PAO-PA7 Output Configurable external 1/0 bus High \t/)v;?/nongzsdriven
PB0-PB1 Input Not used Pulled up on RCM3000
PB2-PB5 Input Configurable external 1/0 bus High \t/)v;??ontc:ltjgriven
PB6-PB7 Output Not used Pulled up on RCM3000

PCO Output Not used High (disabled)

PC1 Input Not used Pulled up on RCM3000

PC2 Output TXC High (disabled)

Serial Port C
PC3 Input RXC Pulled up on RCM3000
PC4 Output TXB High (disabled)
Serial Port B
PC5 Input RXB Pulled up on RCM3000
PC6 Output TXA Programming Port High (disabled)
Serial Port A

PC7 Input RXA Programming Port Pulled up on RCM3000

PDO Output Ethernet RSTDRV High

PD1 Input Not used Pulled up on RCM3000
PD2-PD4 Output Not used High

PD5 Input Not used ProFt)(l)J':i/T)(:nugpggar q
PD6-PD7 Output Not used High
PEO-PE1 Output Not used High

PE2 Output Ethernet AEN High

PE3 Output LCD device select Low (disabled)

PE4 Output IrDA speed select Low (disabled)

PES Output Not used High

PE6 Output External 1/O strobe High (disabled)

PE7 Output Not used High (disabled)
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Table B-2. RCM30/31/32XX Prototyping Board
Use of Rabbit 3000 Parallel Ports (continued)

Port I/O Use Initial State
Pulled up on
PFO-PF7 Input Reserved for future use Prototyping Board
PGO Input Switch S3 (normally open) High
PG1 Input Switch S2 (normally open) High
PG2 Output TXF IrDA Pulled down
Serial Port F
PG3 Input RXF IrDA Driven by IrDA driver
Pulled up on
PG4 Input IrDA MD1 Prototyping Board
Pulled down on
PG5 Input IrDA MDO Prototyping Board
PG6 Output LED DS1 High (disabled)
PG7 Output LED DS2 High (disabled)
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APPENDIX C. LCD/KEYPAD MODULE

An optional LCD/keypad is available for the Prototyping Board.
Appendix C describes the LCD/keypad and provides the soft-
ware function calls to make full use of the LCD/keypad.

C.1 Specifications

Two optional LCD/keypad modules—with or without a panel-mounted bezel—are available
for use with the Prototyping Board. They are shown in Figure C-1.

LCD/Keypad Modules

00000000 eo0o0o0o0o0

<JolvB>
-Q+Q4

Snofan
20a

Figure C-1. LCD/Keypad Modules Models

Only the version without the bezel can mount directly on the Prototyping Board; if you
have the version with a bezel, you will have to remove the bezel to be able to mount the
LCD/keypad module on the Prototyping Board. Either version of the LCD/keypad module
can be installed at a remote location up to 60 cm (24") away. Contact your Rabbit Semi-
conductor sales representative or your authorized Rabbit Semiconductor distributor for
further assistance in purchasing an LCD/keypad module.
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Mounting hardware and a 60 cm (24") extension cable are also available for the LCD/key-
pad module through your sales representative or authorized distributor.

Table C-1 lists the electrical, mechanical, and environmental specifications for the LCD/
keypad module.

Table C-1. LCD/Keypad Specifications

Parameter Specification
RS
Bezel Size 4.50" x 3.60" x 0.30"

(114 mm x 91 mm % 7.6 mm)

Temperature Storage Ranges 40°C 1o 185°C
Humidity 5% to 95%, noncondensing
Power Consumption 1.5 W maximum”
Connections Connects to high-rise header sockets on the Prototyping Board
LCD Panel Size 122 x 32 graphic display
Keypad 7-key keypad
LEDs Seven user-programmable LEDs

* The backlight adds approximately 650 mW to the power consumption.

The LCD/keypad module has 0.1"

IDC headers at J1, J2, and J3 for L l.0.100
physical connection to other boards or 29
ribbon cables. Figure C-2 shows the
LCD/keypad module footprint. These P
values are relative to one of the T R
mounting holes. gs
NOTE: All measurements are in ¥ D S,
inches followed by millimeters G
enclosed in parentheses. All dimen- 52
sions have a manufacturing toler- g8e v
ance of £0.01" (0.25 mm). -3
0.200 |__,|.0.500,
(5.1) (12.7)
1.450
(36.8)
2.200
(55.9)

Figure C-2. User Board Footprint for
LCD/Keypad Module
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C.2 Contrast Adjustments for All Boards

Starting in 2005, LCD/keypad modules were factory-configured to optimize their contrast
based on the voltage of the system they would be used in. Be sure to select a KDU5V
LCD/keypad module for use with the RCM3000/3100/3200 Prototyping Board — these
modules operate at 5 V. You may adjust the contrast using the potentiometer at R2 as
shown in Figure C-3. LCD/keypad modules configured for 3.3 V should not be used with
the 5V RCM3000/3100/3200 Prototyping Board because the higher voltage will reduce
the backlight service life dramatically.

LCD/Keypad Module Jumper Configurations

i Pins Factory
ey Description Connected Default
28V 1-2 X
J5 33V 34
5V nc.
Contrast
Adjustment [ - g 2 O
u3| - i %5 CR1
]

on

R14
(I
=
=
& a7
o
Ul

6
on

on
R11
=
1 =
=
A

R13
1 (7]
=

i
zar §ae
J3

Part No. 101-0541

DISPLAY
BOARD

O

Figure C-3. LCD/Keypad Module Voltage Settings

You can set the contrast on the LCD display of pre-2005 LCD/keypad modules by adjust-
ing the potentiometer at R2 or by setting the voltage for 5 V by removing the jumper across
pins 1-2 on header J5 as shown in Figure C-3. Only one of these two options is available
on these LCD/keypad modules.

NOTE: Older LCD/keypad modules that do not have a header at J5 or a contrast adjust-
ment potentiometer at R2 are limited to operate only at 5V, and will work with the
Prototyping Board. The older LCD/keypad modules are no longer being sold.
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C.3 Keypad Labeling

The keypad may be labeled according to your needs. A template is provided in Figure C-4
to allow you to design your own keypad label insert.

(28)

2.35
(60)

Figure C-4. Keypad Template

To replace the keypad legend, remove the old legend and insert your new legend prepared
according to the template in Figure C-4. The keypad legend is located under the blue key-
pad matte, and is accessible from the left only as shown in Figure C-5.

Keypad label is located

under the blue keypad matte. O Q000000 O

<JrRvl»
- N+ Q4

Figure C-5. Removing and Inserting Keypad Label

)
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C.4 Header Pinouts
Figure C-6 shows the pinouts for the LCD/keypad module.

J1

/ICS |v o|/RES

DB7B |o o | DB6B
+5BKLT (o m| VCC

DB5B | o o | DB4B
DB3B |o o | DB2B
DB1B |o o | DBOB
AOB [0 o|A1B

A2B [0 o|A3B

GND |o o | GND
GND |o o| LED7
LED6 |o o | LED5S
LED4 |o o | LED3
LED2 |o o | LED1

GND
DB6B
DB4B
DB2B
DBOB
AOB |Z ©| A1B

J3 J2

A2B |- B | A3B
PE7 |© = |/RES

GND | © | GND
+5BKLT |- ®|VvCC

GND | = ©|LED7
LED6 | & O |LED5S
LED4 |o O |LED3

LED2 | o o |LED1

GND |o ©
DB7B |0 ©
DB5B |0 O
DB3B |0 ©
DB1B |0 ©

Figure C-6. LCD/Keypad Module Pinouts

C.4.1 1/O Address Assignments

The LCD and keypad on the LCD/keypad module are addressed by the /CS strobe as
explained in Table C-2.

Table C-2. LCD/Keypad Module Address Assignment

Address Function
0xCO000 Device select base address (/CS)
OXCxx0-0xCxx7 LCD control
OxCxx8 LED enable
0xCxx9 Not used
OXCxxA 7-key keypad
0xCxxB (bits 0-6) 7-LED driver
0xCxxB (bit 7) LCD backlight on/off
OXCxxC—-ExxF Not used

User’s Manual

7



C.5 Mounting LCD/Keypad Module on the Prototyping Board

Install the LCD/keypad module on header sockets J7, J8, and J10 of the Prototyping Board
as shown in Figure C-7. Be careful to align the pins over the headers, and do not bend
them as you press down to mate the LCD/keypad module with the Prototyping Board.

RRRR

QQRQOOOOOOOOOOOOO0OQOQ0OO 4

m®" 000000000000000J
0000000000000000000000)
0000000000000000000000)
""" i 0000000000000000000000)
0O00000000000000000000000)
0OO00000000000000000000%

0000000000000 0O
0000000000000 00

cccccc

BOO0O0000000000000

Figure C-7. Install LCD/Keypad Module on Prototyping Board
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C.6 Bezel-Mount Installation

This section describes and illustrates how to bezel-mount the LCD/keypad module. Fol-

low these steps for bezel-mount installation.

1. Cut mounting holes in the mounting panel in accordance with the recommended dimen-
sions in Figure C-8, then use the bezel faceplate to mount the LCD/keypad module onto
the panel.

0125 D, 4x
{/(3) \
JR— ‘ - 7®7 —-
\‘ ‘/
AN //
AN s
AN //
AN /
AN /
AN ,
AN /
AN ;
AN 7
AN s
O/\
<
cuTtout S
// \
, AN
// \
, AN
// \
s AN
// \
s AN
// \
/ AN
//‘ \
*éﬁ ——————————— — S
. 0.230 | 85;‘
(5.8) -
2.870 |
(72.9)
3.100
(78.8)

Figure C-8. Recommended Cutout Dimensions

2. Carefully “drop in” the LCD/keypad module with the bezel and gasket attached.
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3. Fasten the unit with the four 4-40 screws and washers included with the LCD/keypad
module. If your panel is thick, use a 4-40 screw that is approximately 3/16" (5 mm)
longer than the thickness of the panel.

/7 Bezel/Gasket

Om Om OEN ON ON Om Om
FCUEMD20D 200 200 200 2Eg
Bl

Figure C-9. LCD/Keypad Module Mounted in Panel (rear view)

Carefully tighten the screws until the gasket is compressed and the plastic bezel face-
plate is touching the panel.

Do not tighten each screw fully before moving on to the next screw. Apply only one or
two turns to each screw in sequence until all are tightened manually as far as they can
be so that the gasket is compressed and the plastic bezel faceplate is touching the panel.
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C.6.1 Connect the LCD/Keypad Module to Your Prototyping Board

The LCD/keypad module can be located as far as 2 ft. (60 cm) away from the RCM30/31/
32XX Prototyping Board, and is connected via a ribbon cable as shown in Figure C-10.
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Figure C-10. Connecting LCD/Keypad Module to RCM30/31/32XX Prototyping Board

Note the locations and connections relative to pin 1 on both the Prototyping Board and the
LCD/keypad module.

Rabbit Semiconductor offers 2 ft. (60 cm) extension cables. Contact your authorized Rab-
bit Semiconductor distributor or a sales representative for more information.
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C.7 LCD/Keypad Module Function Calls

When mounted on the Prototyping Board, the LCD/keypad module uses the auxiliary 1/0
bus on the Rabbit 3000 chip. Remember to add the line

#define PORTA AUX IO

to the beginning of any programs using the auxiliary 1/0 bus.
C.7.1 LCD/Keypad Module Initialization

The function used to initialize the LCD/keypad module can be found in the Dynamic C
LIB\DISPLAYS\LCD122KEY7.LIB library.

void dispInit();

Initializes the LCD/keypad module. The keypad is set up using keypadDef () or keyConfig () after
this function call.

RETURN VALUE
None.

C.7.2 LEDs

When power is applied to the LCD/keypad module for the first time, the red LED (DS1)
will come on, indicating that power is being applied to the LCD/keypad module. The red
LED is turned off when the brdInit function executes.

One function is available to control the LEDs, and can be found in the nzs\pzsprays\
Lcp122kEY7 . L1B library.

void ledOut (int led, int wvalue);

LED on/off control. This function will only work when the LCD/keypad module is installed on the
Prototyping Board.

PARAMETERS
led is the LED to control.

0=LED DS1
1=LED DS2
2=LED DS3
3=LED DS4
4 = LED DS5
5=LED DS6
6 = LED DS7

value is the value used to control whether the LED is on or off (0 or 1).
0 = off
1=on

RETURN VALUE
None.
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C.7.3 LCD Display

The functions used to control the LCD display are contained in the GrRaAPHIC.LIB library
located in the Dynamic C p1sPLAYS\GRAPHIC library directory.

void glInit(void);

Initializes the display devices, clears the screen.

RETURN VALUE
None.

SEE ALSO

glDispOnOFF, glBacklight, glSetContrast, glPlotDot, glBlock, glPlotDot,
glPlotPolygon, glPlotCircle, glHScroll, glVScroll, glXFontInit, glPrintf,
glPutChar, glSetBrushType, glBufflLock, glBuffUnlock, glPlotLine

void glBackLight (int onOff) ;

Turns the display backlight on or off.
PARAMETER
onOf £ turns the backlight on or off

1—turn the backlight on
0—turn the backlight off

RETURN VALUE
None.

SEE ALSO
glInit, glDispOnoff, glSetContrast

void glDispOnOff (int onOff) ;

Sets the LCD screen on or off. Data will not be cleared from the screen.
PARAMETER
onOf £ turns the LCD screen on or off

1—turn the LCD screen on
O0—turn the LCD screen off

RETURN VALUE
None.

SEE ALSO
glInit, glSetContrast, glBackLight
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void glSetContrast (unsigned level) ;

Sets display contrast.

NOTE: This function is not used with the LCD/keypad module since the support circuits
are not available on the LCD/keypad module.

void glFillScreen (char pattern);

Fills the LCD display screen with a pattern.

PARAMETER
The screen will be set to all black if pattern is OXFF, all white if pattern is 0x00, and vertical stripes
for any other pattern.

RETURN VALUE
None.

SEE ALSO
glBlock, glBlankScreen, glPlotPolygon, glPlotCircle

void glBlankScreen (void) ;

Blanks the LCD display screen (sets LCD display screen to white).

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlock, glPlotPolygon, glPlotCircle

void glBlock(int x, int y, int bmWidth,
int bmHeight) ;

Draws a rectangular block in the page buffer and on the LCD if the buffer is unlocked. Any portion of the
block that is outside the LCD display area will be clipped.

PARAMETERS
x is the x coordinate of the top left corner of the block.
y is the y coordinate of the top left corner of the block.
bmWidth is the width of the block.
bmWidth is the height of the block.

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlankScreen, glPlotPolygon, glPlotCircle
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void glPlotVPolygon(int n, int *pFirstCoord) ;

Plots the outline of a polygon in the LCD page buffer, and on the LCD if the buffer is unlocked. Any
portion of the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are
specified, the function will return without doing anything.

PARAMETERS
n is the number of vertices.
*pFirstCoord is a pointer to array of vertex coordinates: x1,y1, x2,y2, x3,y3,...

RETURN VALUE
None.

SEE ALSO
glPlotPolygon, glFillPolygon, glFillVPolygon

void glPlotPolygon(int n, int yl, int x2, int y2,

o)

Plots the outline of a polygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any
portion of the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are
specified, the function will return without doing anything.

PARAMETERS
n is the number of vertices.
y1is the y coordinate of the first vertex.
x1 is the x coordinate of the first vertex.
y2 is the y coordinate of the second vertex.
x2 is the x coordinate of the second vertex.
. . . are the coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
glPlotVPolygon, glFillPolygon, glFillVPolygon
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void glFillVPolygon(int n, int #*pFirstCoord) ;

Fills a polygon in the LCD page buffer and on the LCD screen if the buffer is unlocked. Any portion of
the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are specified,
the function will return without doing anything.

PARAMETERS
n is the number of vertices.
*pFirstCoord is a pointer to array of vertex coordinates: x1,y1, x2,y2, x3,y3,...

RETURN VALUE
None.

SEE ALSO
glFillPolygon, glPlotPolygon, glPlotVPolygon

void glFillPolygon(int n, int x1, int yl, int x2,
int y2, ...);

Fills a polygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the
polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are specified, the
function will return without doing anything.

PARAMETERS
n is the number of vertices.

x1 is the x coordinate of the first vertex.
y1is the y coordinate of the first vertex.
x2 is the x coordinate of the second vertex.
y2 is the y coordinate of the second vertex.

. . . are the coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
glFillVPolygon, glPlotPolygon, glPlotVPolygon

void glPlotCircle(int xc, int yc, int rad);

Draws the outline of a circle in the LCD page buffer and on the LCD if the buffer is unlocked. Any por-
tion of the circle that is outside the LCD display area will be clipped.

PARAMETERS
xc is the x coordinate of the center of the circle.

ye is the y coordinate of the center of the circle.
rad is the radius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glFillCircle, glPlotPolygon, glFillPolygon

86 RabbitCore RCM3000



void glFillCircle(int xc, int yc, int rad);
Draws a filled circle in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the
circle that is outside the LCD display area will be clipped.

PARAMETERS
xc is the x coordinate of the center of the circle.

ye is the y coordinate of the center of the circle.
rad is the radius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glPlotCircle, glPlotPolygon, glFillPolygon

void glXFontInit (fontInfo *pInfo, char pixWidth,
char pixHeight, unsigned startChar,
unsigned endChar, unsigned long xmemBuffer) ;

Initializes the font descriptor structure, where the font is stored in xmem.
PARAMETERS

*pInfo is a pointer to the font descriptor to be initialized.

pixWidth is the width (in pixels) of each font item.

pixHeight is the height (in pixels) of each font item.

startChar is the value of the first printable character in the font character set.

endChar is the value of the last printable character in the font character set.

xmemBuf fer is the xmem pointer to a linear array of font bitmaps.

RETURN VALUE
None.

SEE ALSO
glPrinf

unsigned long glFontCharAddr (fontInfo *pInfo,
char letter);

Returns the xmem address of the character from the specified font set.

PARAMETERS
*pInfo is the xmem address of the bitmap font set.
letter isan ASCII character.

RETURN VALUE
xmem address of bitmap character font, column major, and byte-aligned.

SEE ALSO
glPutFont, glPrintf
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void glPutFont (int x, int y, fontInfo *pInfo,
char code) ;
Puts an entry from the font table to the page buffer and on the LCD if the buffer is unlocked. Each font

character's bitmap is column major and byte-aligned. Any portion of the bitmap character that is outside
the LCD display area will be clipped.

PARAMETERS
x is the x coordinate (column) of the top left corner of the text.
y is the y coordinate (row) of the top left corner of the text.
*pInfo is a pointer to the font descriptor.
code is the ASCII character to display.

RETURN VALUE
None.

SEE ALSO
glFontCharAddr, glPrintf

void glSetPfStep(int stepX, int stepY):;

Setsthe glPrint£ () printing step direction. The x and y step directions are independent signed values.
The actual step increments depend on the height and width of the font being displayed, which are multi-
plied by the step values.

PARAMETERS
stepX isthe glPrintf x step value
stepY is the glPrint£ y step value

RETURN VALUE
None.

SEE ALSO
Use glGetP£fStep () to examine the current x and y printing step direction.

int glGetPfStep(void) ;

Gets the current glPrint £ () printing step direction. Each step direction is independent of the other,
and is treated as an 8-bit signed value. The actual step increments depends on the height and width of the
font being displayed, which are multiplied by the step values.

RETURN VALUE
The x step is returned in the MSB, and the y step is returned in the LSB of the integer result.

SEE ALSO
Use glGetP£fStep () to control the x and y printing step direction.
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void glPutChar (char ch, char *ptr, int *cnt,
glPutCharInst *plInst)
Provides an interface between the STDIO string-handling functions and the graphic library. The
STDIO string-formatting function will call this function, one character at a time, until the entire format-

ted string has been parsed. Any portion of the bitmap character that is outside the LCD display area will
be clipped.

PARAMETERS
ch is the character to be displayed on the LCD.

*ptr is not used, but is a place holder for STDIO string functions.
*cnt is not used, is a place holder for STDIO string functions.
*pInst is a font descriptor pointer.

RETURN VALUE
None.

SEE ALSO
glPrintf, glPutFont, doprnt

void glPrintf (int x, int y, fontInfo *pInfo,
char *fmt, ...);

Prints a formatted string (much like print£) on the LCD screen. Only the character codes that exist in
the font set are printed, all others are skipped. For example, \b', \t', \n' and \r' (ASCII backspace, tab,
new line, and carriage return, respectively) will be printed if they exist in the font set, but will not have
any effect as control characters. Any portion of the bitmap character that is outside the LCD display area

will be clipped.

PARAMETERS
x is the x coordinate (column) of the top left corner of the text.

y is the y coordinate (row) of the top left corner of the text.
*pInfo is a font descriptor pointer.

*£mt is a formatted string.

. . . are formatted string conversion parameter(s).

EXAMPLE
glprintf (0,0, &£fil2x16, "Test %d\n", count);

RETURN VALUE
None.

SEE ALSO
glXFontInit
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void glBufflock (void) ;

Increments LCD screen locking counter. Graphic calls are recorded in the LCD memory buffer and are
not transferred to the LCD if the counter is non-zero.

NOTE: glBuffLock() and glBuffUnlock () can be nested up to a level of 255, but be
sure to balance the calls. It is not a requirement to use these procedures, but a set of
glBuffLock () and glBuffUnlock () bracketing a set of related graphic calls speeds
up the rendering significantly.

RETURN VALUE
None.

SEE ALSO
glBuffUnlock, glSwap

void glBuffUnlock(void) ;

Decrements the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD
if the counter goes to zero.

RETURN VALUE
None.

SEE ALSO
glBuffLock, glSwap

void glSwap (void) ;

Checks the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD if the
counter is zero.

RETURN VALUE
None.

SEE ALSO
glBuffUnlock, glBuffLock, glSwapData (located in the library specifically for the LCD
that you are using)

void glSetBrushType (int type);

Sets the drawing method (or color) of pixels drawn by subsequent graphic calls.

PARAMETER
type value can be one of the following macros.
PIXBLACK draws black pixels.
PIXWHITE draws white pixels.
PIXXOR draws old pixel XOR'ed with the new pixel.
RETURN VALUE
None.

SEE ALSO
glGetBrushType
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int glGetBrushType (void) ;

Gets the current method (or color) of pixels drawn by subsequent graphic calls.

RETURN VALUE
The current brush type.

SEE ALSO
glSetBrushType

void glPlotDot (int x, int y);

Draws a single pixel in the LCD buffer, and on the LCD if the buffer is unlocked. If the coordinates are

outside the LCD display area, the dot will not be plotted.

PARAMETERS
x is the x coordinate of the dot.
y is the y coordinate of the dot.

RETURN VALUE
None.

SEE ALSO
glPlotline, glPlotPolygon, glPlotCircle

void glPlotLine(int x0, int yO,

int x1, int y1);

Draws a line in the LCD buffer, and on the LCD if the buffer is unlocked. Any portion of the line that is

beyond the LCD display area will be clipped.
PARAMETERS

x0 is the x coordinate of one endpoint of the line.

y0 is the y coordinate of one endpoint of the line.

x1 is the x coordinate of the other endpoint of the line.

y1 is the y coordinate of the other endpoint of the line.

RETURN VALUE
None.

SEE ALSO
glPlotDot, glPlotPolygon, glPlotCircle

User’s Manual

91



void glLeftl (int left, int top, int cols, int rows);

Scrolls byte-aligned window left one pixel, right column is filled by current pixel type (color).

PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glHScroll, glRightl

void glRightl (int left, int top, int cols, int rows);

Scrolls byte-aligned window right one pixel, left column is filled by current pixel type (color).

PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glHScroll, glLeftl

void glUpl(int left, int top, int cols, int rows);

Scrolls byte-aligned window up one pixel, bottom column is filled by current pixel type (color).

PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glvScroll, glDownl
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void glDownl (int left, int top, int cols, int rows);

Scrolls byte-aligned window down one pixel, top column is filled by current pixel type (color).
PARAMETERS

left is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.

cols is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glvScroll, glUpl

void glHScroll (int left, int top, int cols,
int rows, int nPix);

Scrolls right or left, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.

Parameters will be verified for the following:

1. The Left and cols parameters will be verified that they are evenly divisible by 8. If not, they will
be truncated to a value that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling area is valid. The minimum scrolling area is
a width of 8 pixels and a height of one row.
PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8.
top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.
rows is the number of rows in the window.
nPix is the number of pixels to scroll within the defined window (a negative value will produce a scroll
to the left).

RETURN VALUE
None.

SEE ALSO
glvScroll
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void glVScroll (int left, int top, int cols,

int rows, int nPix);
Scrolls up or down, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.
Parameters will be verified for the following:

1. The 1eft and cols parameters will be verified that they are evenly divisible by 8. If not, they will
be truncated to a value that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling area is valid. The minimum scrolling area is
a width of 8 pixels and a height of one row.

PARAMETERS

RE

SE

left is the top left corner of bitmap, must be evenly divisible by 8.

top is the top left corner of the bitmap.

cols is the number of columns in the window, must be evenly divisible by 8.

rows is the number of rows in the window.

nPix is the number of pixels to scroll within the defined window (a negative value will produce a scroll
up).

TURN VALUE

None.

E ALSO
glHScroll

void glXPutBitmap (int left, int top, int width,

int height, unsigned long bitmap) ;

Draws bitmap in the specified space. The data for the bitmap are stored in xmem. This function calls
glXPutFastmap automatically if the bitmap is byte-aligned (the left edge and the width are each
evenly divisible by 8).

Any portion of a bitmap image or character that is outside the LCD display area will be clipped.

PARAMETERS

left is the top left corner of the bitmap.
top is the top left corner of the bitmap.
width is the width of the bitmap.
height is the height of the bitmap.

bitmap is the address of the bitmap in xmem.

RETURN VALUE

None.

SEE ALSO

glXPutFastmap, glPrintf

94

RabbitCore RCM3000



void glXPutFastmap(int left, int top, int width,
int height, unsigned long bitmap);

Draws bitmap in the specified space. The data for the bitmap are stored in xmem. This function is like
glXPutBitmap, except that it is faster. The restriction is that the bitmap must be byte-aligned.

Any portion of a bitmap image or character that is outside the LCD display area will be clipped.

PARAMETERS
left is the top left corner of the bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.
width is the width of the bitmap, must be evenly divisible by 8, otherwise truncates.

height is the height of the bitmap.

bitmap is the address of the bitmap in xmem.

RETURN VALUE
None.

SEE ALSO
glXPutBitmap, glPrintf

int TextWindowFrame (windowFrame *window,
fontInfo *pFont, int x, int y, int winWidth,

int winHeight)

Defines a text-only display window. This function provides a way to display characters within the text

window using only character row and column coordinates. The text window feature provides end-of-line

wrapping and clipping after the character in the last column and row is displayed.

NOTE: Execute the TextwindowFrame function before other Text. .. functions.

PARAMETERS

*window is a window frame descriptor pointer.

*pFont is a font descriptor pointer.

x is the x coordinate of where the text window frame is to start.

y is the y coordinate of where the text window frame is to start.

winWidth is the width of the text window frame.

winHeight is the height of the text window frame.
RETURN VALUE

0—window frame was successfully created.

-1—x coordinate + width has exceeded the display boundary.
-2—y coordinate + height has exceeded the display boundary.
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void TextGotoXY (windowFrame *window, int col,
int row) ;

Sets the cursor location on the display of where to display the next character. The display location is
based on the height and width of the character to be displayed.

NOTE: Execute the TextwindowFrame function before using this function.
PARAMETERS
*window is a pointer to a font descriptor.
col is a character column location.
row is a character row location.

RETURN VALUE
None.

SEE ALSO
TextPutChar, TextPrintf, TextWindowFrame

volid TextCursorl.ocation (windowFrame *window,
int *col, int *row);

Gets the current cursor location that was set by a Graphic Text. . . function.
NOTE: Execute the TextwindowFrame function before using this function.
PARAMETERS
*window is a pointer to a font descriptor.
*col is a pointer to cursor column variable.
*row iS a pointer to cursor row variable.

RETURN VALUE
Lower word = Cursor Row location
Upper word = Cursor Column location

SEE ALSO
TextGotoXY, TextPrintf, TextWindowFrame, TextCursorLocation

void TextPutChar (struct windowFrame *window, char ch);

Displays a character on the display where the cursor is currently pointing. If any portion of a bitmap
character is outside the LCD display area, the character will not be displayed.

NOTE: Execute the TextWindowFrame function before using this function.

PARAMETERS
*window is a pointer to a font descriptor.
ch is a character to be displayed on the LCD.

RETURN VALUE
None.

SEE ALSO
TextGotoXY, TextPrintf, TextWindowFrame, TextCursorLocation
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void TextPrintf (struct windowFrame *window,
char *fmt, ...);
Prints a formatted string (much like print£) on the LCD screen. Only printable characters in the font
set are printed, also escape sequences, "\r' and "\n' are recognized. All other escape sequences will be

skipped over; for example, \b" and 't' will print if they exist in the font set, but will not have any effect as
control characters.

The text window feature provides end-of-line wrapping and clipping after the character in the last col-
umn and row is displayed.
NOTE: Execute the TextWwindowFrame function before using this function.
PARAMETERS
*window is a pointer to a font descriptor.
*fmt is a formatted string.
. . . are formatted string conversion parameter(s).

EXAMPLE
TextPrintf (&TextWindow, "Test %d\n", count);

RETURN VALUE
None.

SEE ALSO
TextGotoXY, TextPutChar, TextWindowFrame, TextCursorLocation
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C.7.4 Keypad

The functions used to control the keypad are contained in the Dynamic C LIB\KEYPADS\
KEYPAD7 .LIB library.

void keyInit (void);

Initializes keypad process

RETURN VALUE
None.

SEE ALSO
brdInit

void keyConfig(char cRaw, char cPress,
char cRelease, char cCntHold, char cSpdLo,
char cCntLo, char cSpdHi) ;

Assigns each key with key press and release codes, and hold and repeat ticks for auto repeat and
debouncing.

PARAMETERS
cRaw is a raw key code index.

1x7 keypad matrix with raw key code index assignments (in brackets):

[0] [1] (2] (3]
[4] [5] (6]

User Keypad Interface
cPress is a key press code

An 8-bit value is returned when a key is pressed.
0 = Unused.

See keypadDef () for default press codes.
cRelease is a key release code.

An 8-bit value is returned when a key is pressed.
0 = Unused.

cCntHold is a hold tick.

How long to hold before repeating.
0 = No Repeat.

cSpdLo is a low-speed repeat tick.

How many times to repeat.
0 = None.

cCntLo is a low-speed hold tick.

How long to hold before going to high-speed repeat.
0 = Slow Only.
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cSpdHi is a high-speed repeat tick.

How many times to repeat after low speed repeat.
0 = None.

RETURN VALUE
None.

SEE ALSO
keyProcess, keyGet, keypadDef

Scans and processes keypad data for key assignment, debouncing, press and release, and repeat.

NOTE: This function is also able to process an 8 x 8 matrix keypad.

RETURN VALUE
None

SEE ALSO
keyConfig, keyGet, keypadDef

Get next keypress

RETURN VALUE
The next keypress, or 0 if none

SEE ALSO
keyConfig, keyProcess, keypadDef

Push keypress on top of input queue

PARAMETER
cKey

RETURN VALUE
None.

SEE ALSO
keyGet
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void keypadbDef () ;

Configures the physical layout of the keypad with the desired ASCII return key codes.

Example: Do the followingfor the above physical vs. ASCII return key codes.

Keypad physical mapping 1 x 7

0 4 1 5 2 6 3
[L1] (U] [D1] [R1]
[-] [+] [E]
where

'E' represents the ENTER key

‘D' represents Down Scroll

'U' represents Up Scroll
'R’ represents Right Scroll
'L represents Left Scroll

keyConfig
keyConfig
keyConfig
keyConfig
keyConfig
keyConfig
keyConfig

~ e~~~ o~~~

3,'R',0,
6,'E',0,
2,'D',0,
4,'-',0,
i,'u',o0,
5,'+',0,
0,'L',0,

0,
0,
0,

0,
0,
0,

0,
0,
0,

0);
) ;
) ;
) ;
)
)
)

O O ©O O o o

Characters are returned upon keypress with no repeat.

RETURN VALUE
None.

SEE ALSO

keyConfig,

keyGet, keyProcess

void keyScan(char *pcKeys) ;

Writes "1" to each row and reads the value. The position of a keypress is indicated by a zero value in a bit
position.

PARAMETER

*pcKeys is the address of the value read.

RETURN VALUE
None.

SEE ALSO

keyConfig,

keyGet, keypadDef,

keyProcess
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C.8 Sample Programs

Sample programs illustrating the use of the LCD/keypad module with the Prototyping
Board are provided in the sSAMPLES\RCM3000 directory.

These sample programs use the auxiliary 1/0 bus on the Rabbit 3000 chip, and so the
#define PORTA AUX IO lineis already included in the sample programs.

Each sample program has comments that describe the purpose and function of the pro-
gram. Follow the instructions at the beginning of the sample program. To run a sample
program, open it with the File menu (if it is not still open), compile it using the Compile
menu, and then run it by selecting Run in the Run menu. The RCM3000 must be in
Program mode (see Section 4.3, “Serial Programming Cable”), and must be connected to
a PC using the programming cable as described in the RCM3000 Getting Started Manual.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
The following sample programs are found in the SAMPLES\RCM3000\LCD KEYPAD folder.

e KEYPADTOLED.C—This program demonstrates the use of the external 1/0 bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a key press is detected. The DS1 and DS2 LEDs on the Prototyping
Board will also light up.

® LCDKEYFUN.C—This program demonstrates how to draw primitive features from the
graphic library (lines, circles, polygons), and also demonstrates the keypad with the key
release option.

e SWITCHTOLED.C—This program demonstrates the use of the external 1/0 bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a switch press is detected. The DS1 and DS2 LEDs on the Prototyp-
ing Board will also light up.
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APPENDIX D. POWER SUPPLY

Appendix D provides information on the current requirements
of the RCM3000, and includes some background on the chip
select circuit used in power management.

D.1 Power Supplies

The RCM3000 requires a regulated 3.3 V = 0.15 V DC power source. The RabbitCore
design presumes that the voltage regulator is on the user board, and that the power is made
available to the RCM3000 board through header J2.

An RCM3000 with no loading at the outputs operating at 29.4 MHz typically draws 145 mA.
The RCM3000 will consume an additional 10 mA when the programming cable is used to
connect the programming header, J3, to a PC.

D.1.1 Battery-Backup Circuits

The RCM3000 does not have a battery, but there is provision for a customer-supplied bat-
tery to back up SRAM and keep the internal Rabbit 3000 real-time clock running.

Header J2, shown in Figure D-1, allows access to the external battery. This header makes
it possible to connect an external 3 V power supply. This allows the SRAM and the inter-
nal Rabbit 3000 real-time clock to retain data with the RCM3000 powered down.

External
J2 Battery
VRAM 59 /\Jso VBAT_EXT |./

|
+3.3V 31 O O 32 GND J

Figure D-1. External Battery Connections
at Header J5

A lithium battery with a nominal voltage of 3 VV and a minimum capacity of 165 mA-h is
recommended. A lithium battery is strongly recommended because of its nearly constant
nominal voltage over most of its life.
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The drain on the battery by the RCM3000 is typically 5 pA when no other power is sup-
plied. If a 165 mA-h battery is used, the battery can last more than 3 years:

165 mA-h

5 A = 3.7 years.

The actual life in your application will depend on the current drawn by components not on
the RCM3000 and the storage capacity of the battery. The RCM3000 does not drain the
battery while it is powered up normally.

Cycle the main power off/on on the RCM3000 after you install a backup battery for the
first time, and whenever you replace the battery. This step will minimize the current drawn
by the real-time clock oscillator circuit from the backup battery should the RCM3000
experience a loss of main power.

NOTE: Remember to cycle the main power off/on any time the RCM3000 is removed
from the Protoyping Board or motherboard since that is where the backup battery
would be located.

D.1.2 Reset Generator

The RCM3000 uses a reset generator to reset the Rabbit 3000 microprocessor when the
voltage drops below the voltage necessary for reliable operation. The reset occurs between
2.85 V and 3.00 V, typically 2.93 V. The RCM3000 has a reset output, pin 1 on header J2.

D.2 Optional +5 V Output

The RCM3000 RabbitCore boards have an onboard charge pump that provides the +5 V
needed by the RealTek Ethernet chip.

There is provision to have the +5 V supply available on pin 33 of header J2, but the default
configuration for the 0 Q surface-mounted jumpers does not bring out this option. Consult
your Rabbit Semiconductor or Rabbit Semiconductor sales representative for more infor-
mation on quantity orders for this option. If the +5 V output option is enabled, you will be
able to draw up to 40 mA.
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APPENDIX E. MOTOR CONTROL
FEATURES

The RCM30/31/32XX Prototyping Board has a header at J6 for a
motor control connection. While Rabbit Semiconductor does not have
the drivers or a compatible stepper motor control board at this time,
this appendix provides additional information about Parallel Port F on
the Rabbit 3000 microprocessor to enable you to develop your own
application.

E.1 Overview

The Parallel Port F connector on the Prototyping Board, J6, gives access to all 8 pins of
Parallel Port F, along with +5 V. This appendix describes the function of each pin, and the
ways they may be used for motion-control applications. It should be read in conjunction
with the Rabbit 3000 Microprocessor User’s Manual and the RCM3000 and the
RCM30/31/32XX Prototyping Board schematics.
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E.2 Header J6

The connector isa 2 x 5, 0.1" pitch header suitable for connecting to an IDC receptacle
with the following pin allocations.

Table E-1. RCM30/31/32XX Prototyping Board Header J6 Pinout

Pin Rabbit 3000 Primary Function | Alternate Function 1 | Alternate Function 2

Quadrature decoder 1 Q

1 Parallel Port F, bit 0 | General-purpose 1/O port input

SCLK_D

Quadrature decoder 1 |

2 Parallel Port F, bit 1 | General-purpose 1/0O port input

SCLK_C

3 Parallel Port F, bit 2 | General-purpose 1/O port %gﬁ?rature decoder2Q | _

4 Parallel Port F, bit 3 | General-purpose 1/O port i(?]:z(zrature decoder 21 | _

Quadrature decoder 1 Q

5 Parallel Port F, bit 4 | General-purpose 1/O port | PWMIO0] output input

Quadrature decoder 1 |

6 Parallel Port F, bit5 | General-purpose 1/0 port | PWM[1] output input

Quadrature decoder 2 Q

7 Parallel Port F, bit 6 | General-purpose 1/O port | PWM[2] output input

Quadrature decoder 2 |

8 Parallel Port F, bit 7 | General-purpose 1/O port | PWM[3] output input

9 +5V External buffer logic supply

10 ov Common

All eight Parallel Port F lines are pulled up internally to +3.3 V via 100 kQ resistors.
When used as outputs, the port pins will sink up to 6 mA ata Vo of 0.4 V max. (0.2 V

typ), and source up to 6 mA ata Vg of 2.2 V typ. When used as inputs, all pins are 5V
tolerant.

As the outputs from Parallel Port F are compatible with 3.3 V logic, buffers may be
needed when the external circuit drive requirements exceed the 2.2 V typ logic high and/or
the 6 mA maximum from the Rabbit 3000. The +5 V supply output is provided for supply-
ing interface logic. When used as inputs, the pins on header J6 do not require buffers
unless the input voltage will exceed the 5 V tolerance of the processor pins. Usually, a
simple resistive divider with catching diodes will suffice if higher voltage inputs are
required. If the outputs are configured for open-drain operation, they may be pulled up to
+5 V (while observing the maximum current, of course).
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E.3 Using Parallel Port F

Parallel Port F is a byte-wide port with each bit programmable for data direction and drive.
These are simple inputs and outputs controlled and reported in the Port F Data Register.
As outputs, the bits of the port are buffered, with the data written to the Port F Data Regis-
ter transferred to the output pins on a selected timing edge. The outputs of Timer Al,
Timer B1, or Timer B2 can be used for this function, with each nibble of the port having a
separate select field to control this timing. These inputs and outputs are also used for
access to other peripherals on the chip.

As outputs, Parallel Port F can carry the four Pulse Width Modulator outputs on PF4-PF 7
(J6 pins 5-8). As inputs, Parallel Port F can carry the inputs to the quadrature decoders on
PFO-PF3 (J6 pins 1-4). When Serial Port C or Serial Port D is used in the clocked serial
mode, two pins of Port F (PFO / J6:1 and PF1/ J6:2) are used to carry the serial clock sig-
nals. When the internal clock is selected in these serial ports, the corresponding bit of
Parallel Port F is set as an output.

E.3.1 Parallel Port F Registers

Data Direction Register—PFDDR, address 00111111 (0x3F), write-only, default value on
reset 00000000. For each bit position, write a 1 to make the corresponding port line an
output, or 0 to produce an input.

Drive Control Register—PFDCR, address 00111110 (0x3E), Write-only, no default on
reset (port defaults to all inputs). Effective only if the corresponding port bits are set as
outputs, each bit set to 1 configures the corresponding port bit as open drain. Setting the
bit to 0 configures that output as active high or low.

Function Register—PFFR, address 00111101 (0x3D), Write-only, no default on reset.
This register sets the alternate output function assigned to each of the pins of the port.
When set to 0, the corresponding port pin functions normally as an output (if configured to
be an output in PFDDR). When set to 1, each bit sets the corresponding pin to have the
alternate output function as shown in the summary table at the end of this section.

Control Register—PFCR, address 00111100 (0x3C), Write-only, default on reset
xx00xx00. This register sets the transfer clock, which controls the timing of the outputs on
each nibble of the output ports to allow close synchronization with other events. The sum-
mary table at the end of this section shows the settings for this register. The default values
on reset transfer the output values on CLK/2.

Data Register—PFDR, address 00111000 (0x38), Read or Write, no default value on
reset. On read, the current state of the pins is reported. On write, the output buffer is writ-
ten with the value for transfer to the output port register on the next rising edge of the
transfer clock, set in the PFCR.
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Table E-2. Parallel Port F Registers

Register Name Mnemonic I/O Address R/W Reset Value
Port F Data Register PFDR 00111000 (0x38) R/W XXXXXXXX
Bits Value Description
0:7 Read Current state of pins
Write P_o_rt buffer. Value transferred to O/P register on next
rising edge of transfer clock.
Port F Control Register PFCR 00111100 (0x3C) |W only xx00xx00
Bits Value Description
0:1 00 Lower nibble transfer clock is CLK/2
01 Lower nibble transfer clock is Timer Al
10 Lower nibble transfer clock is Timer B1
11 Lower nibble transfer clock is Timer B2
2:3 XX These bits are ignored
4:5 00 Upper nibble transfer clock is CLK/2
01 Upper nibble transfer clock is Timer Al
10 Upper nibble transfer clock is Timer B1
11 Upper nibble transfer clock is Timer B2
6:7 XX These bits are ignored
Port F Function Register PFFR 00111101 (0x3D) |W XXXXXXXX
Bits Value Description
0:7 0 Corresponding port bits function normally
0 1 Bit O carries SCLK_D
1 1 Bit 1 carries SCLK_C
2:3 X No effect
4 1 Bit 4 carries PWMIJ0] output
5 1 Bit 5 carries PWMI[1] output
6 1 Bit 6 carries PWM][2] output
7 1 Bit 7 carries PWM][3] output
Port F Drive Control Register PFDCR 00111110 (OX3E) |W XXXXXXXX
Bits Value Description
0:7 0 Corresponding port bit is active high or low
1 Corresponding port bit is open drain
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Table E-2. Parallel Port F Registers (continued)

Register Name Mnemonic I/O Address R/W Reset Value
Port F Data Direction Register PFDDR 00111111 (Ox3F) W 00000000
Bits Value Description
0:7 0 Corresponding port bit is an input
1 Corresponding port bit is an output
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E.4 PWM Outputs

The Pulse-Width Modulator consists of a 10-bit free-running counter and four width regis-
ters. Each PWM output is high for n + 1 counts out of the 1024-clock count cycle, where n
is the value held in the width register. The PWM output high time can optionally be spread
throughout the cycle to reduce ripple on the externally filtered PWM output. The PWM is
clocked by the output of Timer A9. The spreading function is implemented by dividing
each 1024-clock cycle into four quadrants of 256 clocks each. Within each quadrant, the
Pulse-Width Modulator uses the eight MSBs of each pulse-width register to select the base
width in each of the quadrants. This is the equivalent to dividing the contents of the pulse-
width register by four and using this value in each quadrant. To get the exact high time, the
Pulse-Width Modulator uses the two LSBs of the pulse-width register to modify the high
time in each quadrant according to Table E-3 below. The “n/4” term is the base count, and
is formed from the eight MSBs of the pulse-width register.

Table E-3. PWM Outputs

Pulse Width LSBs 1st 2nd 3rd 4th
00 n/4+1 n/4 n/4 n/4
01 n/4+1 n/4 n/4+1 n/4
10 n/4 +1 n/4 +1 n/4 +1 n/4
11 n/4+1 nf4+1 n/4+1 n/4+1

The diagram below shows a PWM output for several different width values for both
modes of operation. Operation in the spread mode reduces the filtering requirements on
the PWM output in most cases.

n=255, normal

(256 counts)

n=255,spread (64 counts) (64 counts) (64 counts) (64 counts)

(65 counts) (64 counts) (64 counts) (64 counts)

n=256, spread |

[ ] [ ] [ ]

[ 1 [ ] [ ]
n=257,spread | | o5 councer | | tes counre || iss counce

[ 1 [ ] [ ]

[ 1 [ ] [ ]

(64 counts)

n:25815pread (65 counts) (65 counts) (65 counts) (64 counts)

] 1 13

n:259,5pread (65 counts) (65 counts) (65 counts) (65 counts)

n=259, normal | (260 counts)

Figure E-1. PWM Outputs for Various Normal and Spread Modes

110 RabbitCore RCM3000



E.5 PWM Registers

There are no default values on reset for any of the PWM registers.

Table E-4. PWM Registers

PWM LSBs Register Address
PWLOR 10001000 (0x88)
PWLIR 10001010 (0X8A)
PWL2R 10001100 (0x8C)
PWL3R 10001110 (Ox8E)
Bit(s) Value Description
76 Write The least significant two bits for the Pulse Width Modulator count are
stored
5:1 These bits are ignored.
0 0 PWM output High for single block.
1 Spread PWM output throughout the cycle
PWM MSB x Register Address
PWMOR Address = 10001001 (0x89)
PWM1R Address = 10001011 (0x8B)
PWM2R Address = 10001101 (0x8D)
PWM3R Address = 10001111 (Ox8F)
Bit(s) Value Description
The most significant eight bits for the Pulse-Width Modulator count
20 write are stored

With a count of n, the PWM output will be high for n +1 clocks out of
the 1024 clocks of the PWM counter.
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E.6 Quadrature Decoder

The two-channel Quadrature Decoder accepts inputs via Parallel Port F from two external
optical incremental encoder modules. Each channel of the Quadrature Decoder accepts an
in-phase (1) and a quadrature-phase (Q) signal, and provides 8-bit counters to track shaft
rotation and provide interrupts when the count goes through the zero count in either direc-
tion. The Quadrature Decoder contains digital filters on the inputs to prevent false counts
and is clocked by the output of Timer A10. Each Quadrature Decoder channel accepts
inputs from either the upper nibble or lower nibble of Parallel Port F. The I signal is input
on an odd-numbered port bit, while the Q signal is input on an even-numbered port bit.
There is also a disable selection, which is guaranteed not to generate a count increment or
decrement on either entering or exiting the disable state. The operation of the counter as a
function of the I and Q inputs is shown below.

}nterrupt

Figure E-2. Operation of Quadrature Decoder Counter

The Quadrature Decoders are clocked by the output of Timer A10, giving a maximum
clock rate of one-half of the peripheral clock rate. The time constant of Timer A10 must be
fast enough to sample the inputs properly. Both the I and Q inputs go through a digital fil-
ter that rejects pulses shorter than two clock periods wide. In addition, the clock rate must
be high enough that transitions on the | and Q inputs are sampled in different clock cycles.
The Input Capture (see the Rabbit 3000 Microprocessor Users Manual) may be used to
measure the pulse width on the | inputs because they come from the odd-numbered port
bits. The operation of the digital filter is shown below.

e /
pospied \____\ /
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The Quadrature Decoder generates an interrupt when the counter increments from 0x00 to
0x01 or when the counter decrements from 0x00 to OXFF. Note that the status bits in the
QDCSR are set coincident with the interrupt, and the interrupt (and status bits) are cleared

by reading the QDCSR.

Table E-5. Quadrature Decoder Registers

Register Name Mnemonic Address
Quaq Decode Control/Status QDCSR 10010000 (0x90)
Register
Bit Value Description
7 . .
0 Quadrature Decoder 2 did not increment from OXFF.
(rd-only)
1 Quadrature Decoder 2 incremented from OxFF to
0x00. This bit is cleared by a read of this register.
6
0 Quadrature Decoder 2 did not decrement from 0x00.
(rd-only)
1 Quadrature Decoder 2 decremented from 0x00 to
OxFF. This bit is cleared by a read of this register
5 0 This bit always reads as zero.
4
0 No effect on the Quadrature Decoder 2.
(wr-only)
1 Reset Quadrature Decoder 2 to 0x00, without
causing an interrupt.
3
0 Quadrature Decoder 1 did not increment from OXFF.
(rd-only)
1 Quadrature Decoder 1 incremented from OxFF to
0x00. This bit is cleared by a read of this register.
2
0 Quadrature Decoder 1 did not decrement from 0x00.
(rd-only)
1 Quadrature Decoder 1 decremented from 0x00 to
OxFF. This bit is cleared by a read of this register.
1 0 This bit always reads as zero.
Bit Value Description
0
0 No effect on the Quadrature Decoder 1.
(wr-only)
1 Reset Quadrature Decoder 1 to 0x00, without
causing an interrupt.
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Table E-5. Quadrature Decoder Registers (continued)

Register Name Mnemonic Address
QU (B2l G QDCR Address = 10010001 (0x91)
Register
Bit Value Description

Disable Quadrature Decoder 2 inputs. Writing a new
7:6 0x value to these bits will not cause Quadrature
Decoder 2 to increment or decrement.

Quadrature Decoder 2 inputs from Port F bits 3 and

10 5
1 Quadrature Decoder 2 inputs from Port F bits 7 and
6.
5:4 XX These bits are ignored.

Disable Quadrature Decoder 1 inputs. Writing a new
3:2 0x value to these bits will not cause Quadrature
Decoder 1 to increment or decrement.

Quadrature Decoder 1 inputs from Port F bits 1 and

10 0

1 Quadrature Decoder 1 inputs from Port F bits 5 and
4,

1.0 0 Quadrature Decoder interrupts are disabled.

1 Quadrature Decoder interrupt use Interrupt Priority
1.

10 Quadrature Decoder interrupt use Interrupt Priority
2.

1 Quadrature Decoder interrupt use Interrupt Priority
3.

QDCI1R Address = 10010100 (0x94)

Quad Decode Count Register
(QDC2R) Address = 10010110 (0x96)

Bit(s) Value Description

The current value of the Quadrature Decoder

7.0 read counter is reported.

114 RabbitCore RCM3000



INDEX

A Dynamic C ......ccoovevvvviennnnnn. 29 H
add-on modules ................. 33
additional information sample programs .............. 12 hardware connections ............. 6
Getting Started manual ....... 3 standard features ............. 30 install RCM3000 on Prototyp-
online documentation .......... 4 debugging .....oeevvee. 30 ing Board .........ccccoevnnee 6
auxiliary 1/Obus ......cccceeveee 21 telephone-based technical power Supply ....ccceevevenennne 8
software ................. 21, 31, 82 SUPPOIT oo 33 programming cable ............. 7
B upgrades and patches ........ 33 hardware reset .........ccocveevrvennee. 8
USB port settings ................ 9 I
battery backup E
battery life ........ccccoeenes 104 1/0 address assignments
external battery connec- Ethernet cables ..., 35 LCD/keypad module ......... 77
tions ..o, 103 Ethernet connections ....... 35, 37 1/0 buffer sourcing and sinking
real-time clock ............... 104 10BaSE-T oo 37 limits ..o, 58
reset generator ................ 104 10Base-T Ethernet card .... 35 1/0 drivers
board initialization additional resources .......... 47 SOFtWAre .....ccoevviiiiiiiin, 31
function calls ..................... 32 direct connection ............... 37 IP addresses ........coceeveeennnn 39
brdinit ..., 32 Ethernet cables ................. 37 how to set in sample programs
bus loading ..o 54 Ethernet hUD wveeeeeee 35 44
IP addresses ................ 37,39 how to set PC IP address .. 45
C i
SEEPS v 35, 36 J
clock doubler .........cccocuvenn... 26 Ethernetport .......ccooeeenn. 22
conformal coating ................. 59 PINOUL ..o 22 jumper configurations ........... 60
exclusion zone .........cccceeneee. 51 JP1 (flash memory bank
D E =] (101 ) [ 27, 60
Development Kit ..................... 5 JP2 (flash memory size) .... 60
RCM3000 v 3 featlres ..o, 1 JP3 (flash memory size) .... 60
Aigital 1O v 16 Prototyping Board .....62,63  JP4(SRAMSIze) .......... 60
I/0 buffer sourcing and sink-  flash memories JP5 (auxiliary IO data bus)
ing I|m|t3 ...................... 58 Software macros L AR 6 O
memory interface ............ 21 USE_2NDFLASH_CODE jumper locations ................ 60
SMODEQ ovviviiiiiii, 21,23 29 K
SMODEL ....ovvvrrnrrneens 21,23  flash memory addresses
dimensions user blocks ..........cccceiiines 27 keypad template ................... 76
LCD/keypad module ......... 73 removing and inserting la-
LCD/keypad template ....... 76 bel v, 76
Prototyping Board ............. 65
RCM3000 .......ccovreirieninen. 50
User’s Manual 115



L

LCD/keypad module
bezel-mount installation ....79

dimensions ........ccceevreennas 73
function calls
dispInit .....c.ccovviiine, 82
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physical mounting ................. 53
pinout
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programming cable ............. 105

PROG connector ............... 24

RCM3000 connections ........ 7
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0113701 ] S 69
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SCHEMATICS

090-0136 RCM3000 Schematic

www.rabbit.com/documentation/schemat/090-0136.pdf

090-0137 RCM30/31/32XX Prototyping Board Schematic

www.rabbit.com/documentation/schemat/090-0137.pdf

090-0156 LCD/Keypad Module Schematic

www.rabbit.com/documentation/schemat/090-0156.pdf

090-0128 Programming Cable Schematic

www.rabbit.com/documentation/schemat/090-0128.pdf

You may use the URL information provided above to access the latest schematics directly.
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